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� ����� ������ (What is research)?� ����� ������ (What is research)?
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� � �!��"#��� �� $%�� �&�'$� ��� ������� ����� �� ������� – ���	
���� ����� 
��� ��������� (relations or correlations of variables) (
�����, 2007). 

� ��! #�%��! �!� �&��!� ���*+���� #���-" ��� #���/%!�1� �� 3�1��� ��! #�%��! �!� �&��!� – ���*+���� #���-" ��� #���/%!�1�, �� 3�1�� 
�!��"#��� ����� � 4�5����#$� 4��* 3$��� #���-" ��� #���/%!�1� �3*�&�� 
���������� ���������� (systematic co-variation) (4��* 3$��� '!%�'6 �� 
�%%�8�� ���� ��#�� �!� #��� #���/%!�6� ����'�"����� �3$ ��������&���%%�8�� ���� ��#�� �!� #��� #���/%!�6� ����'�"����� �3$ ��������&�� 
����!#���4�� �%%�8�� ���� ��#�� �!� *%%!� #���/%!�6�). 

� ��!� 3���3���! 3�� #���-" ��� #���/%!�1� �3*�&�� ����!#���46 
��##���/�%6 �� �!��"#��� ����� '"�: 

�) �� �4+������ ! �3*�&���� ��##���/�%6 �������	 – ��������	 #� 
����������� ������� �� ����� 4������������� ������� �� ����� 4�� 

/) �� 4�5������� ! 
��� (nature) ��� ��	������ �����������, '!%�'6 �� 
4�5������� 4��* 3$��� ! �&��! ����� ������� 6 $&�. 
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�&����� #���-" #���/%!�1��&����� #���-" #���/%!�1�
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� � �&��! #���-" '"� #���/%!�1� ����� ������� (causal), $��� 4*5� 
#���/�%6 ���� ��#�� �!� 3�1�!� #���/%!�6� (�����) ����3*8���� –
3��4�%�� ����!#���4�� �%%�8�� ���� ��#�� �!� '�"���!� #���/%!�6�3��4�%�� ����!#���4�� �%%�8�� ���� ��#�� �!� '�"���!� #���/%!�6� 
(�3���%��#�). 

� ���� ����1'��� �&����� �3*�&�� ������� ������ ����� ��� ��� 
���������: 3��!8����� ! �%%�86 ��! #���/%!�6 – ����� 4�� �3���� ! 
#���/�%6 ��!� #���/%!�6 – �3���%��#� (����� � �3���%��#�). 

� � �&��! #���-" '"� #���/%!�1� ����� ���������������� ����������� � �&��! #���-" '"� #���/%!�1� ����� ���������������� ���������� 
(relationship with effect of third held constant), $��� #�� «����!» 
#���/%!�6 �3!��*��� ��� '"� #���/%!��� 3��� �!� �'�� 4���"5���!, 
'!%�'6 ! «����!» #���/%!�6 ����� �� ���� ��� ����������� ��� ���'!%�'6 ! «����!» #���/%!�6 ����� �� ���� ��� ����������� ��� ��� 
���������. 
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����"3��! ��$&�� #��� �����������"3��! ��$&�� #��� �������
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� � ���
� 3�� #3���� �� 3*��� ! �������� ��� ������������� 
������ ��� ������� ����� (�����4��$3��%��, 1993�): 

�)  ��������� ������� (Research hypothesis), ! �3��� ����� #�� 
4���+���46 3�$���! ��!� �3��� �3���31����� ���� 
��84�4��#���� ��$&�� #��� ������� �� 3�$/%�=! 8�� ����84�4��#���� ��$&�� #��� ������� �� 3�$/%�=! 8�� �� 
���#��$#��� �3���%��#��� �!� ������� 4�� 

/)  ��������� ������ (Research question), �� �3��� ����� #�� /) � � � �� ( q ), #
���������� ������, �� ��5" 6 3%*8�� %$8�, $3�� 
�3���31����� ���� ��84�4��#���� ��$&�� �!� ������� �3%1� �� 

� " 5 � 5 � � * + *�� �!��"#��� �� �����!5�� – �3���!5��, &���� 4�#�* ���+��* 
��� ���#��$#��� �3���%��#���.  
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� �3���!#���46 �����!��46 #�5�'��� �3���!#���46 �����!��46 #�5�'��
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� � ������������ ���������� ������� ����� ��� �'������� 
������ ���!�� �� ����� �������	���, ��� �3���� 
��������� �������	 ������� ����� (�����4��$3��%��, ���� ��� ���  	 � � ��  � � ( ���� ��$ �� ��,
1993�, 1993/):  

�) ��&���� $�� 8�� �� ���� �� ����� ������, 3��3�� �� 
���������� �� � ��������	 ������� �� '�'�#������������� �� � ��������	 �������, �� '�'�#��� 
'!%�'6 �!� �#3����46� 3��8#���4$�!���.

/) 	3��4�3�� ��! ���������, '!%�'6 ��! �������� ������� 
���� – ������� �� �3���� �� 4�%"3���� �� 3���8�*+��� 4������ – ������� �� �3���� �� 4�%"3����, �� 3���8�*+��� 4�� 
�� ��#!��"��� $�� �� '����$� ���"����� �#*'�� – 4��!8����� 
+����#����.  
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������� ��������  �!" �#!$%�µ��!&
������'� �  ��� ��!��%�(��  $�$%�!)#�*(�&
���������  �")���#�µ+��� �#�"� ���,� "�!-+���� –
���#�"� ���,� �#�� µ.���

������ 1 �	���	�-
���
������ 

/���

������ 2

�0�������� �	�
������� ����������� 

����%!)� ��()µ��!&
����%!)� � �������"� µ+��� ��� ��1���,� �"%%!)�& ��� ���!µ+���

/���

������ 2 ����%!)� � �������"� µ+��� ��� ��1���,� �"%%!)�& ��� ���!µ+���
��#��µ'& �'�!" ��� 1#'�!" ���2�)�)�& � & +#�"��&
����+%��  �#!����#����,� – ���#�"� ���,� �#�"�,�

�
����� �	�
������� ����������
����� �	�
������� ���������

��")�#'� �  ��� !µ.��� ��.%"� &
����+%��  ���#�µ����,� ��#�µ$.����
�����+#)��� µ��#�����

������ 3

����������� /���

����
�� ��� �	������ �	�
������� ���������

����������� ���2�#)��(� ��� ���!µ+���
��������"� ���.��� ��� �1����)#�µµ.���
��#����� �2�!%') �  ��� �1!%���µ'& �"# µ.���
���������  �"µ��#��µ.���

������ 4
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������ 5

�1�µ�: �� ��.��� � & �#�"� ����& ����� µ!����& µ�-'�!" (��#����"'�!"%!& 1993�)

/��� ������� 
���	�������

�1�µ�: �� ��.��� � & �#�"� ����& ����� µ!����& µ�-'�!" (��#����"'�!"%!&, 1993�)
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� ���� ������� 3�%%�� +���� &�!��#�3������� ! ����������������
���������� (multi-methodological approach), �"#+��� #� �!� �3��� �� 
#�� ������ ������� � ��������������� ��	
���� ����������� 
� � 1 � 1 *������� �� ������������, 1��� ! #�� �� ��#3%!�1��� �!� *%%! 

(�����4��$3��%��, 1993�, 1993/). 
� �3��!� 3�%%�� +���� &�!��#�3������� ! ����
���� ���������!�

( lti h li ) " + � �� �(multiphase sampling), �"#+��� #� �!� �3��� ��!� ��� �����
#3���"� �� ��������������� ������ ��
�������� �������� �� � 
��
������	 ���� ��� ������ (�����4��$3��%��, 1993/). �*%����, 
4*3��� �3$ �� �3�4��#��� #3���"� �� «�����������» �� ����������4*3��� �3$ �� �3�4��#��� #3���"� �� �����������  �� ���������� 
��� ���� ������. 

� ��� #�� �4���6 ���+��* ��� ������� ������ ����  ��������, /%�3� 
Cohen & Manion (2000) 4�� �����4��$3��%�� (1993� 4�� 1993/).       ( ) � � ( /)
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� 
����� 
. (2007). "� �������� ���������� ��� 
����	��� #������  �������� �� �� ������ ���� 
����������� ��'�4����46 '�����/6 #6#� ��������46� 4�������������. ��'�4����46 '�����/6. #6#� ��������46� 4�� 
	�+�%����46� �3���6#!�. ����3���6#�� ������1�.

� Cohen L. & Manion L. (2000). Reserch Methods in Education 
(4th Editi ) L d d N Y k R tl d(4th Edition). London and New York: Routledge.      

� �����4��$3��%�� �. �. (1993�). "��������� 
 ������������ $����� (�. 	B). ����3���!#��4�� �� �� � � ( ) !# �
�!#��1����. ����3���6#�� 	5!�1�. 

� �����4��$3��%�� �. �. (1993/). "��������� 
 ������������ $����� (� AB) ����3���!#��4�� ������������ $����� (�. A ). ����3���!#��4�� 
�!#��1����. ����3���6#�� 	5!�1�.
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�� 
����� 
�����������
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)Approaches) 

2

� � $��� ���������	 
�������� (research approach) ��%����� �� ��&�� !�� �� 
'�*%$ ��� "���������!+� �,�#-�� !�� ��� �!$"�%�� "���%'.���� "�� %"���� 
/ / !�� *�,�� �� ��!/��� � �������/� ���� ���*/!�� &��1�#�#/� ��� �������/ / !�� *�,�� �� ��!/��� � �������/� ���� ���*/!�� &��1�#�#/� ��� ������� 
(�����!��$"��,��, 1993�, 1993'). 

� ����� �� �6��,� ��� &��&�!����!+� ��*%����� !�� ��� "���%'���!+� ����#��+� 
���� �"���� "��'����� � �������/� #�� �� %�#����"��/��� ��� �#!��$�������� �"���� "��'����� � �������/�, #�� �� %�#����"��/��� ��� �#!��$����, 
�������!/ !�� �1�����!/, ��� ����%.��� ��� ������� ���.

� �� 
���
������ ��� �������	 �����������: 

�) ���� ����� ��� «������» 
��������� �� �"���� �%",�!����� !�� �7��$� 
��*�6��� �� "���#��7�!. -���!�������!., �7������ %�� &��!�,�6��� �� 
!�*������%� !��. "$��� � �-��� %���16 ��� %���',��+� ����� ����+&�� / 
�����!�*���8$%��� ��%%���'�,/ !�� 

') �� � ���� ����� ��������, ���� !�*����%$ ��� ������	� ������	� ��� ��� 
����������, &�,�&/ ��� �� �"�7��*�6%� #�� �� "��� %���',��/ ����� �� ����� � � � / 7 % # % ' � /
!�� "��� �� �"���,��%�. 
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� ���� ��������!/ %�*�&�,�#�� �� «������» 
��������� ��������
������� �� ��	�: 

�) ���� �������������� 
����������� (naturalistic approaches), !��. �� -�$�� "�� 
. $ ,� ', � � . 7/%���.%� ��� �"$ %�,��� %���',���� �� «������» "��.#����� �7/������ 

�,�6*���� �� ����".�-��� !�� �� �"�&��6�. ��� ����-��� ���� �#���6%� ��� 
�"�&�.���� ��� «������» "���#$���� / "���"�*�6%� �! ��� ������� �� ��� 
�"�,��;��%� �,�#1��%��"�,��;��%� – �,�#1��%�.

') ���� 
���������� 
����������� (experimental approaches), ,�%'.����� %���%��, 
%� ��� !��.,,�,� &����6*%��� ��� ��������!/� &��&�!�����, �� �"�,��7*�6� –

, * 6 & . � $ � + $�,�#-*�6� �� �"�&�.���� ��� «������» "���#$���� �! ��� "�������, +��� $��� 
!.���%� ��� %���/���� �� �-�� �"���%'�� � &��7���"�����!/ &�.�� ��� &6� 
%�,��+%���� %���',��+�, ��+ �� �-��� �1��-/� �1��&�����*�� �� �"�&�.���� 
��� .,,�� "���#$������� .,,�� "���#$����.  
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� ���� ��� ����������� 
�����������, ��.,�#� %� �� ����� 
������������ ���� ���
��� ����� ��� �������� ��������	� ��� 
������ ����� (
����� 2007 Cohen & Manion 2000 !��������, ����� (
�����, 2007, Cohen & Manion, 2000 !�� 
�����!��$"��,��, 1993�, 1993'): 

�) �����������	 – 
������ ��	 
��������,

�) !���������	 
�������� (The experimental method), 

�) "������� ��� ������ ������ (Ex post facto research) ��� 

�) "��� ����	 
�������� (Corellational research).
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� � 8���6%��� ���� ������������ – 
������ ��� ������ ����� � 
!���#��7/ ��� &��7$��� �!7.����� ��$� 7����%����, !�*+� !�� � 
���8/���� !�� � ����"��%$� &��7���$%���� #���!+� �.���� !�����8/���� !�� � ����"��%$� &��7���$%���� #���!+� �.���� !�� 
"�*��+� �-����� %���16 ��� %���',��+� ��� ��������!�6 
"��',/%����. 

� � &���������!/ – "���#��7�!/ "����##��� ����� !��.,,�,� �� ������� 
$"�� �� 8���6%��� ����� !����� � $�� �� &����$� ",�������� 
�"��!$���� ��� "���6��� !��.������ ��$� 7����%���� !�� $-� �$�� ��"��!$���� ��� "���6��� !��.������ ��$� 7����%���� !�� $-� �$�� � 
��%����� ��� 7����%���� %� ��� ����"��%$ ��� �����&+� �-����� !�� � 
#���!���� ��� ����%.��� �� ���6���� �%���&/ �6��,� – ",�*��%�6�. 

�� 
����� 
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�����%���!/ "����##��� (The experimental 
h d)method) 
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� � 
���������	 
�������� (The experimental method) ����� � "����##��� � 
�"��� "���-�� �� %�#�,6���� &����/ '�'��$���� #�� �� "��#%���!. 
"���#��7�!. -���!�������!. !�� ��� �,�*��/ 76�� ��� �-���� %���16 &6�"���#��7�!. -���!�������!. !�� ��� �,�*��/ 76�� ��� �-���� %���16 &6� 
%���',��+�.  

� � ����� ��� ��� ����������� ��� 
���������	� 
���������, ����� (
�����, 
2007)2007):

�) ����&����8��%� %���',���� #�� ��� �"���� �-��%� 1�!�*������ "��� ���%����%� 
�� ����� � ���1.����� (�����) !�� "��� � �1����%��� (�"���,��%�).  

') ���8��%� #�� ��� ���1.����� %���',��/ ���,.-����� &6� ��%�� – �"�"�&�, �� 
�"���� *� �"���,����� ��� "����%���!�� !�����.���� !�� �� �"���� �"�-��� 
��!�6���� %���16 ����.  � � % 1 �

#) �-�%���8��%� �$��� �%.&�� �"�!��%���� $��� !�� �� !�����.���� ��� "���.%���� 
(���,.-����� &6�), "��� �7/���%� �� �"����#/��� � ���1.������ "��.#����� –
����� �� �"���� �� ����� !�*$,� $%���� %���16 ���������, �� �"���� �� ����� !�*$,� $%���� %���16 ����.
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&) 	7/���%� �� !.*� �%.&� �� �"�&�.��� %�� �"$ ��� !�����.���� ��� "���.%���� 
#�� !."��� ��!�6���� %�#.,� -����!$ &�.���%�. 

�) @�����8��%� !��. �� -����!$ &�.���%� ��� �"����#���� ��� ���1.������ 
%���',��/� �� %�� �"�&�.��� !."���� «������ "��.#�����», +��� �� �"���.��� 
&��7���!. $,� / %���!. �"$ �� �"�!��%��� ����%���� �%.&��.

��) �1��7�,�8��%� ��� �#!��� !�� �1�$"���� ;�-�%����!$ %���, +��� �� 
%���/���%� ��� �1����%��� %���',��/ �� $,� �� �"�!��%��� ��� ��,�� ��� 
"���.%����. "���.%����.

8) ��#!�����%� %� ��� !��.,,�,� ��������!/ %�*�&� ��� %���/���� ��� �1����%���� 
%���',��/� %���16 ��� &��7$��� �%.&��.  

A .& � �8 � &6 , 6 ! 	A��� �� �%.&�� �"�!��%���� "�� �-�%���8��%� ����� &6�, !�,�6���� !���������	 
#���� ��� #���� $�����.  

�� 
����� 
�����������

�6#!���� &��7���!+� �%.&�� (Ex post facto
h)research)

8

� � �7��%�#/ ��� ��������� ��� ������ ������ (	 ex post facto ���������) (Ex 
post facto research) "��B"�*���� ��-�!. ��� ����"��%$ &6� �%.&�� 
�"�!��%���� �� �"���� �"�&�&��#%��� &��7����� �� "��� �� %�� %���',��/ (� 
�"��� !�,����� &��7���!/) !�� ��� ����-��� ���� !�*����%$ !��. "$�� ����� �� 
&6� %���',���� &��7����� �� "��� ��� .,,� %���',��/ (� �"��� !�,����� 

$ )��#!���$%���).

� �7$��� %�8� %� ��� &6� %�,��+%���� %���',���� ����"/�-�� !�� �"�&��6��� 
&�.7���� «������» %���',����, �� �"���� ��&�-�%���� �� ��*�6���� �� 
"���#��7�!. -���!�������!., !�*+� !�� �� %�� &��!�,�;��� ���� !�*����%$ 
��� �,�*��/� 76��� ��� ���.7����, � �������/� *� "��"�� �� «�1��&����+���» 
�! ��� ������� ��� �"�&���� ��� «������» %���',��+� ���/*�� %� ��� 

.,, , , / .& � ( .& . �!��.,,�,� �"�,�#/ ��� �%.&�� �"�!��%���� (#�� "��.&��#%� �� !."���� ������ 
"��.#����� �"���.8�� !."��� �"$ �� �"�!��%��� ��� �������, %"���6� �� 
%�������6� ���� &6� �%.&��). 

�� 
����� 
�����������



����7���!/ "����##��� (Correlational 
h)research)
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� � !6��� -���!�������!$ ��� ���� ����	� 
��������� ����� $�� "���"�*�� �� 
%�,��/��� ��� �-����� %���16 ��� %���',��+�, -����%�"��+���� �� %��� ���� 
���*%���!�6� &��!��� ���.7����.  

� �� &��!��� (/ �����,�����) ���.7���� ����� ��������!�� &��!��� "�� 
"�����!�"���6� (�!7�.8��� ���*%���!.) �� '�*%$ ��� ��%%���'�,/� ��� 
%���',��+�. 

� � �7��%�#/ ��� ����7���!/� ������#�!/� "��B"�*���� �� ".���%� ��� %$�� 
&��#%� !�� #�� !.*� �"�!��%��� ��� &��#%���� �� �1��7�,����%� %�� %������ 
#�� !�*�%�. �"$ ��� �"$ %�,��� %���',����. ��� ����-��� �"�,�#�8��%� %� ��� # % � % � % ' � � � - # 8 % % �
!��.,,�,� ��������!/ &��&�!���� ��� ���*%���!/ ��%/ ��� &��!�� ���.7���� 
%���16 ��� %���/����.    

� D�� ",����!��%� ��� ����7���!/� %�*$&�� ����� $�� ��+ � "����%���!/� D�� ",����!��%� ��� ����7���!/� %�*$&�� ����� $�� ��+ � "����%���!/ 
������#�!/ !�� � ex post facto �6#!���� "���&����8��� �� '�*%$ ��� ���.7���� 
�� &����%�!/ &��'.*%��� (�	� / �F�), � ����7���!/ %�*�&�� "���&����8�� �� 
'�*%$ ��� ���.7���� �� ���*%���!/ &��'.*%��� (�"$ 0 �+� �1). ' % �� 7 � � %� / ' % � ( � )

�� 
����� 
�����������

����7���!/ "����##��� (Correlational 
h) ( � )research) (����-���)
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� � ���*%���!/ ���/ �!7���� ��� '�*%�6 ��� ���.7����, "��� �"$ ��� 
,�"��%�������� – ",�������� "���#��7�!/ ��� �1�� !�� ��� &����$����� 
"�� "���7���� ��� &����6���� ��� ���.7���� "�����$����� ��� &6�"�� "���7���� ��� &����6���� ��� ���.7���� "�����$����� ��� &6� 
%���',��+�, %"���� �� -����%�"���*�� ���� �"�,��� &6� �"�",��� 
��������!+� "��',�%.��� (
�����, 2007) : 

�) ���� "�$',�;� ��� ��%+� %��� %���',��/� �"$ ��� ��%�� %��� / 
"����������� .,,�� %���',��+�, %� �� ��������!/ %�*�&� ��� 
"�,��&�$%���� (Regression) !��"�,��&�$%���� (Regression) !�� 

') ���� ����"��%$ *�%�,��!+� &����.���� ��� &�%/ %��� �6�*���� 
"�$�����, %� ��� %�*$&��� ��� ��,�&�.������ 	�.,���� ��&�%���� 
(M l i i D A l i )(Multivariate Data Analysis). 

�� 
����� 
�����������



����7���!/ "����##��� (Correlational 
h) ( � )research) (����-���)
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� �� "��"�� �� ��%��+���%� $�� ���� ����7���!�� �������, �� &����$����� 
#�� �,�#-� ��� «������» "���#$���� ����� ,�#$����� ��#!����!. %� ��� ex 
post facto �6#!���� !�� �!$%� ,�#$����� ��#!����!. %� ��� "����%���!/post facto �6#!���� !�� �!$%� ,�#$����� ��#!����!. %� ��� "����%���!/ 
%�*�&�. 

� �"���� "��',�%���!/ #������ !�� !.*� �"$7��� %�� �-���!. %� ��� 
�,�*��/ 76�� ��� �-����, ��&�!$���� ��+ %"���6%� %���!+� �� 
�"�!,�����%� ��� "���"���� ��� �����!�*���8$%���� ��%%���'�,/�, 
���� "���"���� %��� ����+&��� �-���� &�� %"���6%� �� �"�7��*�6%����� "���"���� %��� ����+&��� �-���� &�� %"���6%� �� �"�7��*�6%� 
#�� �� -����!/ &��&�-/ ��� �"����#���� ��� %���',��+�. 

�� 
����� 
�����������
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� � ex post facto �6#!���� ����� &�6���� �� �#!��$���� "����##���, %��. ��� 
"����%���!/, ����� $%�� ,�#$���� �"������!/ �"$ ��� "����%���!/ "����##���, 
� �"��� ����� ��-�. "�,6 &6�!�,� �� �7��%����� ���� "�.1� !�� "��!��!.� �"��� ����� ��-�. "�,6 &6�!�,� �� �7��%����� ���� "�.1� !�� "��!��!. 
���7�!��, ��+ "�,,�� 7���� !�� ����&�����,�#�!/ (
�����, 2007).   

� � ex post facto �6#!����, � ����7���!/ ������#�!/ !�� � &���������!/ –
"���#��7�!/ "����##��� !����.������� ���� �������������� 
�����������"���#��7�!/ "����##��� !����.������� ���� �������������� 
����������� 
(Naturalistic approaches).   

���������	��
�� 
	������
��

��������
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	������
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(����µ��
�� ���
��� 
	�������� )

���������
� –
���������
� 
	������
�

���
��	 ex post
facto �������
�� 

�µ����

�����µ���
� 
	������
�

������� ���� �� !�	���� ���� ��

� �µ�: "� ��� ��� �������
�� 	������
�� �� ���� �� #��µ� ��	������� 	��� ���� � 
(����	
���������, 1993�)
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Ποσοτικές ερευνητικές προσεγγίσεις (Quantitative Research Approaches) 

∆ρ Κορρές Κωνσταντίνος2

Οι  ποσοτικές μέθοδοι  εφαρμόζονται όταν στόχος της έρευνας είναι ο έλεγχος 
συγκεκριμένων υποθέσεων ή ερωτημάτων για το υπό μελέτη φαινόμενο. 

Οι  ποσοτικές μέθοδοι που βασίζονται σε δειγματοληπτική έρευνα με 
ερωτηματολόγιο, προσφέρουν τη δυνατότητα στον ερευνητή να προσεγγίσει 
μεγάλο μέρος του πληθυσμού για τον έλεγχο των συγκεκριμένων υποθέσεων ή 
ερωτημάτων . 

Η τυποποίηση των στοιχείων που συλλέγονται,  η δυνατότητα προσέγγισης 
μεγάλου μέρους πληθυσμού και η επιδεκτικότητα των στοιχείων σε στατιστικές 
μεθόδους ανάλυσης  καθιστούν την ποσοτική ως την  πιο διαδεδομένη μορφή 
εμπειρικής έρευνας.  

Για να καταλήξει ο ερευνητής σε έγκυρα και επιστημονικά αποτελέσματα δύο 
είναι τα βασικά ζητήματα που πρέπει να εστιάσει: 

α) Στη συλλογή ενός αντιπροσωπευτικού δείγματος του υπό μελέτη πληθυσμού και 

β) Στη διαμόρφωση ενός κατάλληλου για την έρευνα ερωτηματολογίου. 



Δειγματοληψία (Sampling)

∆ρ Κορρές Κωνσταντίνος3

Η ποιότητα μιας έρευνας δεν στηρίζεται μόνο στην καταλληλότητα της μεθοδολογίας 
και της επιλογής των κατάλληλων μέσων, αλλά και στην καταλληλότητα της μεθόδου 
δειγματοληψίας (suitability of the sampling strategy) (Morrison, 1993). 

Παράγοντες όπως έξοδα, χρόνος και προσβασιμότητα συχνά αποτρέπουν τους 
ερευνητές από το να συλλέξουν πληροφορίες για ολόκληρο τον πληθυσμό. Καθώς δεν 
είναι δυνατόν ο ερευνητής να μελετήσει κάθε άτομο στον υπό μελέτη πληθυσμό, είναι 
αναγκασμένος να επιλέξει ένα αντιπροσωπευτικό δείγμα του πληθυσμού αυτού. 

Το αντιπροσωπευτικό δείγμα είναι απαραίτητο στην ποσοτική έρευνα για να μπορέσει 
να οδηγηθεί σε έγκυρα αποτελέσματα και επιτρέπει στον ερευνητή να γενικεύσει τα 
συμπεράσματά του. 

Εάν το δείγμα δεν είναι σωστά επιλεγμένο τότε ο ερευνητής μπορεί να διατυπώσει 
μόνο τάσεις που διαφαίνονται στο συγκεκριμένο δείγμα, για παράδειγμα, οι μαθητές 
του σχολείου στην περιοχή που επιλέχθηκε το δείγμα και όχι να γενικεύει τα 
συμπεράσματά του. 

Δειγματοληψία (Sampling) (συνέχεια)

∆ρ Κορρές Κωνσταντίνος4

Οι έμπειροι ερευνητές ξεκινούν από το συνολικό πληθυσμό και 
προχωρούν στο δείγμα.

Αντίθετα, οι λιγότερο έμπειροι ερευνητές δουλεύουν αντίστροφα, 
δηλαδή αποφασίζουν το ελάχιστο μέγεθος δείγματος το οποίο απαιτείται 
για τη διεξαγωγή της έρευνας τους (Bailey, 1978). 

Όμως, αν δεν καθοριστεί ο συνολικός πληθυσμός στην αρχή, είναι σχεδόν 
αδύνατο να μπορέσει κανείς να αξιολογήσει πόσο αντιπροσωπευτικό 
είναι το δείγμα το οποίο έχει επιλέξει. 



∆ρ Κορρές Κωνσταντίνος5

Σχήµα: Μέγεθος ενός τυχαίου δείγµατος (Cohen & Manion, 2000)

∆ρ Κορρές Κωνσταντίνος6

Σχήµα: Μέγεθος δείγµατος, διαστήµατα εµπιστοσύνης και σφάλµα 
δειγµατοληψίας (Cohen & Manion, 2000)



Επιλεγμένες μέθοδοι δειγματοληψίας (Methods of Sampling) (συνέχεια)

∆ρ Κορρές Κωνσταντίνος7

Παρακάτω παρουσιάζονται κάποιες επιλεγμένες μέθοδοι δειγματοληψίας :  

Απλή τυχαία δειγματοληψία (simple random sampling)

Είναι η πιο διαδεδομένη μέθοδος και κάθε άτομο στον πληθυσμό έχει την ίδια πιθανότητα 
να επιλεγεί στο δείγμα. Συνήθως γίνεται  μέσα από κάποια βάση ή κάποιο κατάλογο όπου 
επιλέγονται τυχαία τα άτομα που θα αποτελέσουν το δείγμα. 

Συστηματική δειγματοληψία (systematic random sampling) 

Είναι παρόμοια με την απλή τυχαία δειγματοληψία αλλά εδώ ο ερευνητής καθορίζει ένα 
συγκεκριμένο τρόπο που θα επιλεγεί το δείγμα. Για παράδειγμα, μέσα από μία βάση με 
3000 άτομα, εάν χρειαζόμαστε 30 για την έρευνα, μπορούμε να ταξινομήσουμε τη βάση και 
να επιλέξουμε το 1ο, το 101ο, το 201ο άτομο κλπ).

Δειγματοληψία κατά στρώματα (stratified random sampling)

Η μέθοδος αυτή εφαρμόζεται όταν ο πληθυσμός είναι μικρός και χωρίζεται σε υποσύνολα ή 
στρώματα τα οποία πρέπει να αντιπροσωπεύονται στο δείγμα. Στην περίπτωση που 
υπάρχει μεγαλύτερο ποσοστό από κάποιο υποσύνολο ή στρώμα στον πληθυσμό μας θα 
πρέπει να επιλέξουμε και στο δείγμα μας μεγαλύτερο ποσοστό από το υποσύνολο αυτό. 

Επιλεγμένες μέθοδοι δειγματοληψίας (Methods of Sampling) (συνέχεια)

∆ρ Κορρές Κωνσταντίνος8

Δειγματοληψία χιονοστιβάδας (snowball sample)

Η μέθοδος αυτή χρησιμοποιείται κυρίως σε ποιοτικές μελέτες. Στο πρώτο στάδιο ο 
ερευνητής επιλέγει ορισμένα άτομα με τα συγκεκριμένα χαρακτηριστικά που επιθυμεί να 
μελετήσει. Στη συνέχεια, τα άτομα αυτά προτείνουν άλλα άτομα που γνωρίζουν και 
συμμετέχουν στην έρευνα. 

Η  μέθοδος αυτή στηρίζεται στη δικτύωση και είναι απαραίτητη σε πληθυσμούς που δεν 
είναι εύκολο να εντοπισθούν με τυχαία δειγματοληψία. 

Μέθοδος διαθέσιμου δείγματος (availability sample)

Υπάρχουν περιπτώσεις όπου οι συνθήκες της έρευνας (χρόνος, κόστος κλπ) δεν επιτρέπουν 
την επιλογή αντιπροσωπευτικού δείγματος. Σε αυτές τις περιπτώσεις χρησιμοποιούμε τη 
μέθοδο του διαθέσιμου δείγματος (availability sample), με την οποία ο ερευνητής επιλέγει 
για το δείγμα του άτομα που δέχονται να συμμετάσχουν στην έρευνα. 

Το διαθέσιμο δείγμα μπορεί να χρησιμοποιηθεί σε αρχική έρευνα για τη δοκιμή ενός 
ερωτηματολογίου ή τη διερεύνηση τάσεων, αλλά δεν μπορεί να χρησιμοποιηθεί για να 
καταλήξει κανείς σε συμπεράσματα ή γενικεύσεις. 



Επιλεγμένες μέθοδοι δειγματοληψίας (Methods of Sampling) (συνέχεια)

∆ρ Κορρές Κωνσταντίνος9

Σκόπιμη δειγματοληψία (purposive sample) 

Στη σκόπιμη δειγματοληψία ο ερευνητής χρησιμοποιεί χαρακτηριστικές περιπτώσεις του 
πληθυσμού που θέλει να μελετήσει.  

Δειγματοληψία αναλογίας (quota sampling) 

Σύμφωνα με αυτή τη μέθοδο, ο ερευνητής, στην προσπάθειά του να επιλέξει ένα 
αντιπροσωπευτικό δείγμα της ομάδας που μελετά, επιλέγει το δείγμα του με συγκεκριμένα 
κριτήρια. Αν και το δείγμα είναι τυχαίο, τα συμπεράσματα και οι γενικεύσεις πρέπει να 
αντιμετωπισθούν με προσοχή. 

Εθελοντικό δείγμα (volunteer sample) 

Το εθελοντικό δείγμα επιλέγεται μέσα από ανακοινώσεις κλπ. Τα αποτελέσματα και τα  
συμπεράσματα πρέπει να αντιμετωπισθούν με την ανάλογη προσοχή καθώς το δείγμα είναι 
επιλεγμένο με συγκεκριμένο τρόπο. 

Το ερωτηματολόγιο (Questionnaire)

∆ρ Κορρές Κωνσταντίνος10

Το συνηθέστερο μέσο συλλογής δεδομένων στις ποσοτικές ερευνητικές 
προσεγγίσεις είναι το ερωτηματολόγιο (Questionnaire), το οποίο στη συνέχεια θα 
αναλυθεί μέσα από τη στατιστική επεξεργασία των δεδομένων. 

Προκειμένου η έρευνα να οδηγήσει σε έγκυρα αποτελέσματα που σχετίζονται με 
το υπό μελέτη θέμα,  το ερωτηματολόγιο ενδείκνυται να περιλαμβάνει 
κατάλληλες ερωτήσεις οι οποίες:

Να σχετίζονται με τους στόχους  της έρευνας.

Να περιλαμβάνουν τα απαραίτητα δημογραφικά χαρακτηριστικά του δείγματος 
ώστε μέσα από τις συσχετίσεις των μεταβλητών να είναι δυνατή η περιγραφή 
τάσεων και χαρακτηριστικών συγκεκριμένων ομάδων.



Το ερωτηματολόγιο (Questionnaire)(συνέχεια)
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Κατά τη διαμόρφωση των ερωτήσεων του ερωτηματολογίου ενδείκνυται :  

Να χρησιμοποιούμε απλή και κατανοητή γλώσσα.

Να χρησιμοποιούμε μικρές ερωτήσεις ώστε να είναι  εύκολα κατανοητές από αυτούς που 
συμπληρώνουν το ερωτηματολόγιο.

Να αποφεύγουμε τις διπλές ερωτήσεις . 

Για παράδειγμα στην ερώτηση «Πόσο ενδιαφέρον βρίσκεται στα Θετικά Μαθήματα;», κάποιος 
από τους ερωτώμενους μπορεί να βρίσκει μεγάλο ενδιαφέρον στα Μαθηματικά, αλλά όχι στη 
Χημεία, έτσι δυσκολεύεται να δώσει απάντηση.

Να αποφεύγουμε ερωτήσεις οι οποίες προκαλούν προκαθορισμένες απαντήσεις.

Σε προτάσεις που αποτελούν αντιπροσωπευτικές θέσεις της κοινωνίας αναμένεται οι 
περισσότεροι να δώσουν απαντήσεις κοινωνικά αποδεκτές. 

Να αποφεύγουμε ερωτήσεις που περιλαμβάνουν άρνηση.

Οι όροι να είναι κατανοητοί από όλες τις κοινωνικές ομάδες. 

Οι νέοι, οι μετανάστες, τα άτομα με χαμηλότερο μορφωτικό επίπεδο, οι άνθρωποι στα αστικά 
κέντρα και τις  αγροτικές περιοχές κατανοούν διαφορετικά το ίδιο ζήτημα. 

Το ερωτηματολόγιο (Questionnaire)(συνέχεια)
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Να αποφεύγουμε ερωτήσεις οι οποίες χρειάζονται ειδικές γνώσεις για να απαντηθούν.

Για παράδειγμα αναφορά σε συγκεκριμένους νόμους, πολιτικές που δεν είναι γνωστές 
όπως «Τι γνώμη έχετε για την πολιτική της κυβέρνησης στο θέμα ……………», δεν είναι 
σίγουρο ότι ο γενικός πληθυσμός γνωρίζει τη συγκεκριμένη πολιτική, οπότε δεν θα 
μπορέσει να απαντήσει και να τη σχολιάσει. 

Να αποφεύγουμε ερωτήσεις οι οποίες λόγω της αναφοράς τους σε ονόματα ή σύμβολα 
προκαλούν συγκεκριμένες απαντήσεις.

Για παράδειγμα η ερώτηση «Ποια είναι η γνώμη σας για την αρνητική στάση της εκκλησίας 
μας στο θέμα ……….», θα έχει άλλη επιρροή σε άτομα με έντονο θρησκευτικό συναίσθημα 
και άλλη σε κάποιον χωρίς.  

Να αποφεύγουμε ερωτήσεις για μη αποδεκτές συμπεριφορές. 

Οι πληροφορίες για ερωτήσεις  του τύπου «Έχετε κακοποιήσει ……….» συλλέγονται έμμεσα 
χωρίς να πρέπει ο ερωτώμενος να παραδεχθεί ότι έχει διαπράξει κάποια μη αποδεκτή 
συμπεριφορά.



Το ερωτηματολόγιο (Questionnaire)(συνέχεια)
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Σε ερωτήσεις με τις οποίες διερευνάται η συχνότητα, να υπάρχουν ως απαντήσεις χρονικά 
καθορισμένα διαστήματα .

Να υπάρχουν απαντήσεις του τύπου Καθημερινά, Κάθε εβδομάδα, Κάθε μήνα κλπ. 

Να δίνεται η δυνατότητα της απάντησης «Δεν γνωρίζω» ή «Δεν απαντώ» .

Η χρήση ενικού ή πληθυντικού είναι ένα θέμα το οποίο πρέπει να αποφασίσει ο ερευνητής ή  
η ερευνητική ομάδα, ανάλογα με το θέμα και την ομάδα στην οποία απευθύνεται. 

Σε ερωτήσεις οι οποίες προκαλούν αμηχανία να γίνονται κατηγοριοποιήσεις στις 
απαντήσεις. 

Για παράδειγμα όπως στην ερώτηση ηλικία, να δίνονται κατηγορίες  όπως 18-22, 23-27 κλπ. 

Να αποφεύγονται σε ερωτήσεις για κοινωνικά αποδεκτά ζητήματα, απαντήσεις  «Συμφωνώ» 
ή  «Διαφωνώ», γιατί  προκαλούν υψηλά ποσοστά αναμενόμενων απαντήσεων. 

Το ερωτηματολόγιο (Questionnaire)(συνέχεια)
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Οι ερωτήσεις χωρίζονται σε κλειστές και ανοιχτές. 

Οι κλειστές ερωτήσεις συνοδεύονται από προκαθορισμένες απαντήσεις . 

Εφόσον δεν μπορούμε να προβλέψουμε όλες τις  πιθανές απαντήσεις πρέπει  να υπάρχει η 
επιλογή «Άλλο….» όπου να δίνεται η δυνατότητα στους ερωτώμενους να  αναφέρουν τις 
δικές τους απαντήσεις. 

Επίσης πρέπει να προβλέπεται η απάντηση « Δεν ξέρω» ή «Δεν είμαι σίγουρος /η» . 

Το μειονέκτημα των κλειστών ερωτήσεων  είναι ότι δεν παρέχουν τη δυνατότητα να 
εκφρασθούν οι αυθόρμητες απαντήσεις των ατόμων του δείγματος, καθώς οι ερωτώμενοι  
επιλέγουν απαντήσεις οι οποίες  είναι πλησιέστερες στις δικές τους απόψεις. 

Οι ανοιχτές ερωτήσεις  επιτρέπουν  στους ερωτώμενους  να διατυπώσουν τη δική τους 
άποψη, στάση, πρακτική. 

Το μειονέκτημα των ανοιχτών ερωτήσεων είναι ότι μένουν συνήθως κενές καθώς απαιτούν 
περισσότερο χρόνο και σκέψη για να απαντηθούν.

Μια άλλη δυσκολία για τον ερευνητή είναι ότι εφόσον θα γίνει στατιστική ανάλυση, οι 
ανοικτές ερωτήσεις πρέπει να κωδικοποιηθούν και να αντιμετωπιστούν  ως κλειστές 
ερωτήσεις στη στατιστική ανάλυση. 



Στάδια εκπόνησης μίας ποσοτικής ερευνητικής προσέγγισης

∆ρ Κορρές Κωνσταντίνος15

Αρχική έρευνα ή Έρευνα πιλότος (Πιλοτική έρευνα) (Pilot research). 

Προτού ο ερευνητής προχωρήσει στην έρευνα πεδίου (συμπλήρωση των ερωτηματολογίων) 
θα πρέπει να ελέγξει το ερωτηματολόγιο σε ένα περιορισμένο δείγμα, το οποίο  συνήθως 
επιλέγεται με τη μέθοδο του διαθέσιμου δείγματος. 

Σε αυτό το στάδιο θα εντοπισθούν ασάφειες, μη κατανοητοί όροι, δυσκολία στην επιλογή 
απάντησης ιδιαίτερα στις κλειστές ερωτήσεις όπου οι απαντήσεις είναι προκαθορισμένες 
κλπ και θα οριστικοποιηθεί το ερωτηματολόγιο.

Έρευνα πεδίου

Σε αυτό το στάδιο συμπληρώνονται τα ερωτηματολόγια. Η συμπλήρωση δεν πρέπει να έχει 
πολύ μεγάλη διάρκεια, ιδιαίτερα σε θέματα που μεταβάλλονται με το χρόνο. Αν αλλάξουν 
ορισμένα δεδομένα πολλές φορές αλλάζουν και οι απαντήσεις του δείγματος και  υπάρχει 
δυσκολία στην ερμηνεία των αποτελεσμάτων. 

Στατιστική επεξεργασία στοιχείων

Τα δεδομένα που συλλέγονται από τα ερωτηματολόγια  κωδικοποιούνται  συνήθως με το 
στατιστικό πακέτο SPSS (Statistical Package for Social Sciences) και γίνεται  παρουσίαση, 
ανάλυση και ερμηνεία των αποτελεσμάτων.

Στάδια εκπόνησης μίας ποσοτικής ερευνητικής προσέγγισης (συνέχεια)

∆ρ Κορρές Κωνσταντίνος16

Ερμηνεία αποτελεσμάτων – Συγγραφή τελικής έκθεσης

Από τη στιγμή που το ερωτηματολόγιο έχει σχεδιασθεί σωστά, το δείγμα είναι 
αντιπροσωπευτικό, οι ερωτήσεις  έχουν γίνει κατανοητές από τους ερωτώμενους και το 
ερωτηματολόγιο έχει συμπληρωθεί σωστά, τα αποτελέσματα της έρευνας  θεωρούνται 
έγκυρα και αντιπροσωπευτικά της υπό μελέτη ομάδας. 

Με βάση τα αποτελέσματα της στατιστικής ανάλυσης, μπορεί να γίνει ερμηνεία  του 
φαινομένου που μελετήθηκε και να εξαχθούν γενικεύσιμα συμπεράσματα. 



Συνολικά για τις ποσοτικές ερευνητικές προσεγγίσεις 
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Η ποσοτική έρευνα είναι μια πολύ χρήσιμη μέθοδος για την περιγραφή και διερεύνηση 
αντικειμενικών χαρακτηριστικών του υπό έρευνα πληθυσμού. 

Είναι μια μέθοδος που συγκεντρώνει αξιόπιστα και έγκυρα στοιχεία που οδηγούν σε 
γενικεύσιμα συμπεράσματα.

Όταν σκοπός της έρευνας είναι η ανάλυση συγκεκριμένων διαστάσεων του υπό μελέτη 
θέματος, πρέπει να μελετηθούν τα ποιοτικά χαρακτηριστικά και όχι τα ποσοτικά. 

Συνήθως χρησιμοποιείται συνδυασμός της ποσοτικής και της ποιοτικής μεθόδου για την 
πληρέστερη κατανόηση και ανάλυση των διαστάσεων του υπό μελέτη θέματος.

Πολλές φορές η ποσοτική προηγείται της ποιοτικής μεθόδου, αλλά υπάρχουν και 
περιπτώσεις όπου ο ερευνητής μέσω της ποιοτικής μεθόδου σε μικρή ομάδα ερωτώμενων, 
μπορεί να οδηγηθεί στο σχεδιασμό του ερωτηματολογίου, μέσω του οποίου θα κάνει την 
έρευνα με την ποσοτική μέθοδο.
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(Qualitative Research Approaches) 

� � ��$������ %�&��� �"'�%�� *�� ������ ���� �	� ��	��	
�� ������	
�� 
����������	� ���� ������� �!� ��"��+���!�. 

� � "������, ������ ��!��-���� ��!� �"&/��! &�� ! ����� �	� ��� �������� 
����	 ������� ����� ��� ���	����� ��� ������	��� ����	����, ���� ��� 
�	�����	 
�	 ���� ���	�������	 ��� ��� ��	�� ��� ��������	����.
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� � "������, ������ ������	 �� ��������� ���� ��� �� ������� �� 

���������� �� ��	��	
� ����
���	��	
� �� �� ������ ��������, �� �"��� 
�� *�� "������, ������ +�� ���+����1�����. 

� ���,/�� %�!��*�"������� �������� �����	
�� 
�	 ��	��	
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���������� 
�������� 
�	 ������ ��� �	�������� �� �� ������ �������.
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�� ������	
�� 
����������	� �����: 

� � �������� (Interview), ! �"��� *"���� �� "'��� ��� *��2�� 

(Cohen & Manion, 2000): 

�  ������� �������� (Standardised open ended interview)
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�  ������� �������� (Standardised open–ended interview)

� !�	
���������� �������� (Semi–structured interview)

� "������� ���� ������ (Interview guide approach)

� #��� �������� ���� �������� (Informal conversational 
interview)

� ! ������ ���	�������

� $	 ������ ���	������� �������� (Focus groups)

�� 
����� 
�����������

� ��������6! (Interview)

� "������� ����� ! ��%���, "�� �%�� ���"& �� ��#��7��� *�� �%��! 
������	
�� ��	
�	������ ��'*��� �� +1� "�&��"�, �� ����������, 
(interviewer) ��� ��� ����7*���, ���� 7��� �� �"����8�� ���� "�7�� 
�! ������ ��	������ ��������	�� �"& �� +�1���� "'�� �� ��� 
��#�����*��� �������*��� (������+!-
�"&$��, 2010). 
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� � ������ "�� #������ *� �! *�/�+� �!� ��������6!� "��"�� �� �%�� 
������	������ �� 
��� ���������	� ��/7� � ����������,� �2��$�� 
�� ����	��� ����	
� �	������, �� ���
����	 �����	���� 
�	 
������	
�� �����������. 

� � "������*���� ���, �"���$�� ��� «����� ���������» ��� 
�"�+�7��� �� �������%�	 ��� �
����� ��� ������ �� �������	� 
(<�$���, 1994).
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� ��������6! (Interview) (����%���)

� � ��������6!, +!*����#�� *�� ��������, ��� 8�%�$�#��, �%��! ��'*��� ��� 
����������, ��� ��� ����7*��� #�� ���& ����� ���������� � �
������� ��� 
������
��� ������ ��
	����� ��� ����� �����. 

� �� ������������ "��"�� �� ��"��+����1� ���� ����� �������	��� ��� ����������, 
�! �����	���� �� �� �����	 �� ��	��	
���� ���' �! +�'����� �!� ��������6!�, 
��/7� ��� �! ������� ��� �
�	���� 
��������� ��� ���������� (���,/�� *� �! 
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� ! �� �� � � �� ��� � ( , � * !
%�,�! ������,� ����#��2,� ,%��). 

� 	"& �! ���#*, �!� "�7�!� �"�2,� ! ���	
� �������� �� ���	����� � �������� 
���� ���������� 
�������	 �� ������ ����� �� �������� ��� ���� �����. 
��! ����%���, � ����� ��� �����, ! �� ��
�	
� ��	
�	����� �$$' ��� �� ���������	� 
�� ������
�� *"���� �� �%��� �!*�����, �"�+���! ��� �"���$��*��� �!� 
������� ��� ��� ?�/*& �6��"������ ����. 

� 
��' �! +�'����� �!� ��������6!� ��� �� �����	 �� �������
����	 ���� �����
�"��+, ����� "�/��&� �� ��������� �	� ��������	� �� ��������� (
����-,, 
2002).

�� 
����� 
�����������

� ��������6! (Interview) (����%���)

� 	"& �! ���#*, "�� /� +�%/�� � ����7*���� �� $'?�� *���� ��!� ������, /� 
"��"�� �� ��!*���/�� #�� �! �	��
�	� ��� ���������. 

� � ����������,� /� "��"�� �� ����� "�$1 "��������&� &��� �2��' �! 
�	������� ��� ��������� ��� ��� ����� �� ���	��� ��	� ��������	� ��� 
���������� ��� +�� /� "��"�� �� �%�$�'-��, �"�+���*'-�� , �"�+���*'-�� *� 
$&#�� , ���,���� ��� �"���,���� ��� ����7*����
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$&#�� , ���,���� ��� �"���,���� ��� ����7*����. 

� �� ������	
�� ���%�	� �� ������
�� ��� �����	 �� �	�������� #���� /� 
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� �� �!� �$��$,���! �!� ��������6!� � ����������,� "��"�� �� +��/���� 
�'"��� %�&�� #�� �� ��������	 �� ���� ������� � ��������� �� 
��������� "�� +�� ����� +����&� �� �"���!/�1� ���' �! +�'����� �!� 
��������6!�.
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� ! �������� �������� (Standardised open–ended interview)

�� ��� &�� ���& ���2��&*���� ��! ��������6! �����! &"�� � ����7*����  
"�����"���� �� �"���,��� �� *�� ����' ����,���� "�� � ��	����, � ��	�� 

�	 �� ���	������� ���
���������	 ��� �� ����� ��� ���������. 

� ! ��	
���������� �������� (Semi–structured interview)
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@�����!��-���� �"& �!� 1"��6! �+!#�1 ��������6!� ��� �"& �� #�#��&� &�� � 
�
���� ��� ��������� ����	 �����	������, %���� &*�� �� ���	
������ �� 
����	 ���	��	�����. 
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�$$' �� *�� "�� �$�1/��! ��-,�!�! "�� �� 
��	� ������ �� ������
�� 
����	 �� ���������	 �� ������� ��� �����	� ��� ������. 

�� 
����� 
�����������

���2�� ��������6!� (����%���) 

� ! �������� ���� ������ (Interview guide approach)

��! *��2, ���, �� /�*��� ��� ����,���� ����� +��*��2�*��� �"& �!� ��%,, 
�� *�� *��2, �%�+���. 

� ����������,� �"�2���-�� �! ����' ��� �� %�����*& ��� ����,���� ���' �!� 
��, �!� ��-,�!�!�. 

8

� ! ���� �������� ���� �������� (Informal conversational interview)

��! *��2, ���, +�� �"'�%�� "����/����*&� ��� /�*'��� ����,���� , �!� 
+���1"��!�. �� ����,���� "���1"���� ���' �!� ��, �!� ��-,�!�!�, %���� 
���& �� �!*����� &�� �� ����,���� /� #����� �� �"���+,"��� /�*� ��� &"�� 
�1%��. 

� ������ *��2, ����1 ��� ��+��� ��������6!� ����� ��  *! �����/��&*���� 
��-!�,���� �� �"���� ��/���7/!��� ��!� 8�%�/���"���.

�� 
����� 
�����������



� ��������6! (Interview) (����%���)

� � ��������6! �"���$�� *�� �"& ��� �	� �����	���� ������� ��� ������ ���� 
��	��	
�� ��� 
�	 �����	
�� ���������  ("������7� +�+�*���� �� �"��� 
�%��� "�������"��!/��). 

� A*�� ! ������ �%�� +��6�� &�� �� ��
�	
�� �������� ���� ��� ����� ��
�	���	 
�� �������� ���	��	����� 
�	 ���������� (Miles, Blum, Staats & Dean, 2003).

9

� 	��& �2��$���� ������ ��� #�#��&� &�� �� ��������	� ��� ���������� 
��������	 �� ���	
���������� ��	 ��	 ����� � �	������, �$$' *'$$�� &�� 
������� � ��	 ��� ������� �� ��� ���� ������
��. 

�� 
����� 
�����������

	�'$��! "����%�*����

� � ����&���! *�/�+�� #�� �!� ��'$��! "������7� ����%���� ����� ! ������ 
���	�������. 

� ��&������ #�� *�� ��"�"��!*��! *�/�+� "�� �+!#�� ��! �������	
� 

��	
������� �� ������� 
�	 �� ������	
�� ���� ��� �� �� ��1���, 
��������%�� ��!� �����	
������� ��� ���������� ��	� ���	
��� �������	� ��� 
��������������� ��� ��� ���	������� ��� �� �����	������ �����������
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��������������� ��� ��� ���	������� ��� �� �����	������ �����������. 

� �1*2��� *� �! *�/�+� ���,: 

i. � ���*��� �6��'-���� ��!� ������� �� 
�	 ��	 ��	��
�	
�.

ii. �� 
��������� "�� %�!��*�"���1���� #�� �!� ��6��&*!�! ��� +�+�*���� 
��������	 �� ������	�, ���� 7��� �� ����� +����, ! �"��'$!8! ��� � �$�#%�� 
�!� +��+������� �"& '$$��� �����!���.

iii. � ����
���	��	
� �� �����������	 ��� 
������ �����	
���	�����	 7��� �� 
+��"����/�� ! �!*���� ���� ��� �+�� ���*��� �$$' ��� �� '$$� ���*���. 

�� 
����� 
�����������



	�'$��! "����%�*���� (����%���)

� ���� �!� ����	��	
�� ������������ ��� ���	����� �����$1"������ ����	��	
�� 
��������	� ?'��� ��� �"���� �$�#%����� �� /���!����� �"�/����� �!� 
�������. 

� 
��' ����"���, ! ��'$��! "����%�*���� �� �����	
� ������� ��	������	 ��� 
��	� 
�	�	
� �� ���������
� �� ����� �� �� �����	����� ������������	� 

�	 �� ����	��	
� ����������� ��� ���	�����

11


�	 �� ����	��	
� ����������� ��� ���	����� . 

� � ?����, ������ 
��������� ($�6!, ������) �"�$�#���� �"& ��� �����!�, �� 
����� �� �� ���	
� ��������� ��� ������. A��� ! *��'+� ����#��2,� +�� 
����� +����&� �� ��*!���/�� "��' *&�� �� �%��! *� �� ��*2��-&*��� 
("�&���!) �&�� ���& �� �
��������� 
�����	 �� ���	������� �������� �� 
������ 
��������� (
����-,, 2002).

�� 
����� 
�����������

�*'+�� ������*��!� ��-,�!�!� (Focus groups)

� � ��$������ %�&��� �%�� "����!�!/�� ��� ������ ���	������ �	� �� 
�	�������� 
�	���	
�� ��	������� 
�	 ������� ��� &
�������� ���� ��� 
�	� ������ ���	������� �������� (Focus groups). 

� � ��+��2���� ���& �%���-���� *� �� #�#��&� &�� �� �"&8��� "�� 
����#�'2����� �� *�� ������ �*'+� ����������	 ���� ��� �� ������������� 
(interaction) ��� ������ �� ���	
� �������

12

(interaction) ��� ������ �� ���	
� �������.

� �� �*'+�� ������*��!� ��-,�!�!� "���$�*?'���� ��� �	
�� ��	��� ������ 
(8-12) �	 �����	 ���� 
���	� 
�	�� ����
���	��	
�.

� � �"�$�#, �!� �*'+�� (+��#*�)  #������ *� ��
�
�	���� 
�	���	� ��� ! 
���	��������	
����� ��� ������ ��������	 ���� ���� �
��������� ���� ��� 
��������	
�� ����
���	��	
�� (21$�, !$����, *��2����& �"�"�+� �$") , ��!� 
��	���� ������ �� ��
�
�	���� ����
���	��	
�, ��'$�#� *� ���� ��&%��� 
�!� �������.

�� 
����� 
�����������



�*'+�� ������*��!� ��-,�!�!� (Focus groups)

� ���� �"& �! ��-,�!�! � �����!�,� "���"�/�� �� ����#�'8�� ��� ���	��%�	�, 
������������	�, ����	���� ���� 
�	 ��� ����� �� �	���� �� ��
�
�	���� 
���� �� '��*� �!� ��#�����*��!� �*'+��. 

� � ��������*&� �!� �*'+�� "��"�� �� #���� �"& ��� ����	�� �������. 

� � �����!�,� /� "��"�� ��  +��/���� �!� ����&�!�� �� ������	 �	� �	����� 

13

������	� 
�	 ���	������	
�� �������	� "�� +!*����#�1���� ��!� �*'+� ��� 
�� ���	������	 ��� ������	
�	
� 
����. 

� � �'/� ���� *��� ��!� �*'+� /� "��"�� �� �
�����	 �������� �	� �
�%�	� 
�� ��� ���& �6���'��� �"& ��� ���������,. 

� ���'$$!$�, ! +���*��, �!� �*'+�� *"���� �� ��/���1��� �� *�$! �!� �� 
�
������� �����	����� 
�	 �����	� �� ������ �� ��� ���
������ 
���	���� ��� �����	� �	�� ����	
�� ���������. 

�� 
����� 
�����������

�*'+�� ������*��!� ��-,�!�!� (Focus groups)

� � *�/�+�� ���, ����� �+������� ��+�+��#*��! #�� �*'+�� &"�� ! ������ 
��������� �� ����	
� ������� ����	 ���
��� ���� $&#� ��� �������� 
������� ���� $&#� ��� 	�	������� ����
���	��	
�� �� ���������.

� � ��-,�!�! 
����������	 �� ���� �����
���� ��� ��/7� +�� ����� �1��$� 
#�� ��� �����!�, �� ����#�'8�� &$�� ��� �"&8��� &"�� +����"7������, 
�2&��� ������� � ���	� ��� ��� ������������
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�2&��� ������� � ���	� ��� ��� ������������. 

� �� �'/� �*'+� �"'�%�� ��� �'"���� ����������� �� ��� ��������	 ��� 
������� 
�	 
���� ����	���	�, �%����' *� �! �� ��
�	
� ��	
�	����� �� 
�
�������	, �	� ������	�, �� ����	
� ��� ������ �$".

�� 
����� 
�����������
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ΕΚΚΙΝΗΣΗ ΤΟΥ SPSS

Κ
ο
ρ
ρ
ές Κ

. (2
0

1
2

). Μ
έθ
ο
δ
ο
ι σ
τα
τισ

τική
ς α

νά
λυσ

η
ς µ

ε τη
 

β
ο
ή
θ
εια

 το
υ S

P
S

S
. Α

.Σ
.Π
Α
Ι.Τ

.Ε
. 

2

Από την Έναρξη των Windows, επιλέγουµε: Προγράµµατα →
→ SPSS for Windows → SPSS *.* for Windows 



Ο EDITOR ΤΟΥ SPSS

3

Όταν ανοίγουµε το SPSS, βλέπουµε τον Editor του SPSS (SPSS Data Editor),
ο οποίος απεικονίζει τα περιεχόµενα του αρχείου δεδοµένων στο οποίο 
εργαζόµαστε.

Στον SPSS Data Editor µπορούµε να έχουµε προβολή και επεξεργασία τόσο 
των δεδοµένων επιλέγοντας Data View όσο και των µεταβλητών επιλέγοντας 
Variable View.
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Ο VIEWER ΤΟΥ SPSS
Πίνακες, στατιστικά στοιχεία και διαγράµµατα απεικονίζονται στον SPSS 
Viewer, ο οποίος ανοίγει αυτόµατα όταν εκτελέσουµε κάποιοι εντολή που 
παράγει κάποιο αποτέλεσµα

Χρησιµοποιούµε τα µενού για να επιλέξουµε στατιστικές µεθόδους -
διαγράµµατα κλπ, τόσο στον SPSS Viewer όσο και στον SPSS Data Editor. 
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ΒΑΣΙΚΗ ∆ΟΜΗ ΕΝΟΣ ΑΡΧΕΙΟΥ ∆Ε∆ΟΜΕΝΩΝ

O Data editor περιέχει τα δεδοµένα και τις µεταβλητές που βρίσκονται 
«φορτωµένες» στη µνήµη από το SPSS και µπορούν να χρησιµοποιηθούν για 
οποιαδήποτε ανάλυση. 

Τα δεδοµένα και οι µεταβλητές µπορούν να εισαχθούν στο SPSS είτε από 
κάποιο αρχείο του SPSS (*. sav), είτε από κάποιο αρχείο του Excel (*.xls) ή από 
κάποιο άλλο αρχείο δεδοµένων, επιλέγοντας: File → Open → Data
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ΒΑΣΙΚΗ ∆ΟΜΗ ΕΝΟΣ ΑΡΧΕΙΟΥ ∆Ε∆ΟΜΕΝΩΝ (ΣΥΝΕΧΕΙΑ) 

Κάθε γραµµή αντιστοιχεί σε µία συγκεκριµένη παρατήρηση 
(observation) ή περίπτωση (case).

Κάθε στήλη αντιστοιχεί σε µία µεταβλητή (variable).

Σε µία έρευνα της Εκπαίδευσης στις οποίες έχουµε ποσοτικά 
δεδοµένα ή ποιοτικά δεδοµένα τα οποία έχουν ποσοτικοποιηθεί
(δηλαδή προέρχονται είτε από ένα ερωτηµατολόγιο ή από 
απαντήσεις σε µία συνέντευξη), 

ένα αρχείο δεδοµένων του SPSS έχει την παρακάτω δοµή: 

i. Κάθε γραµµή είναι µία περίπτωση δηλαδή ένας συγκεκριµένος 
άνθρωπος.

ii. Κάθε στήλη είναι µία µεταβλητή, δηλαδή µία ερώτηση στο 
ερωτηµατολόγιο ή τη συνέντευξη.

iii. Κάθε απάντηση ή άλλο δεδοµένο καταγράφεται στα αντίστοιχα 
κελιά.
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ΕΙΣΑΓΩΓΗ ∆Ε∆ΟΜΕΝΩΝ ΣΤΟ SPSS

Μπορούµε να εισάγουµε τα δεδοµένα στον Data editor:
Ένα ένα από το πληκτρολόγιο

Από ένα αρχείο δεδοµένων του SPSS (*.sav) 

Από ένα αρχείο κειµένου (*.txt) 

Από ένα αρχείο του excel (*.xls) 

Με αντιγραφή και επικόλληση από  ένα  άλλο  ανοιχτό  πρόγραµµα  
των  Windows  (π.χ.  Excel  ή  Word)

Για την εισαγωγή δεδοµένων από το πληκτρολόγιο επιλέγουµε ένα 
κελί, πληκτρολογούµε την τιµή που θέλουµε και πατώντας Enter η 
τιµή καταχωρείται. 

Αν στη µεταβλητή που εισάγουµε τιµές δεν έχουµε ορίσει όνοµα, 
καταχωρείται  αυτόµατα  ένα όνοµα (π.χ. VAR00001). 

Από την προβολή Variable View µπορούµε να αλλάξουµε το όνοµα 
µίας µεταβλητής (στη στήλη Name), αλλά και τις ιδιότητες της 
µεταβλητής.
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ΑΡΧΕΙΟ ∆Ε∆ΟΜΕΝΩΝ – ΟΡΙΣΜΟΣ ΜΕΤΑΒΛΗΤΩΝ
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Παράδειγµα από έρευνα Κορρές (2006) και Κορρές& Καραστάθης (2007)



ΥΠΟΛΟΓΙΣΜΟΣ ΠΕΡΙΓΡΑΦΙΚΩΝ ΣΤΑΤΙΣΤΙΚΩΝ ΜΕΤΡΩΝ

Μπορούµε µε το SPSS να υπολογίσουµε διάφορα στατιστικά µέτρα θέσης 
και διασποράς για µια µεταβλητή, όπως µέγεθος δείγµατος (Sample size), 
µέση τιµή (mean), ελάχιστη τιµή (minimum), µέγιστη τιµή (maximum), 
τυπική απόκλιση (standard deviation), διασπορά (variance), εύρος (range) 
κλπ. 

Από το µενού επιλέγουµε: Analyze → Descriptive Statistics → Descriptives 

Εµφανίζεται ένα παράθυρο διαλόγου (dialog box), στο οποίο επιλέγουµε 
τις µεταβλητές που θέλουµε να χρησιµοποιήσουµε στη συγκεκριµένη 
ανάλυση από την λίστα όλων των µεταβλητών. 

Από τις επιλογές (Options), µπορούµε να επιλέξουµε ποια στατιστικά µέτρα 
θα υπολογιστούν.

Αν επιλέξουµε «Save standardized values as variables» στον πίνακα των 
δεδοµένων προστίθενται νέες µεταβλητές οι οποίες περιέχουν ως τιµές τις 
τυποποιηµένες τιµές των αρχικών µεταβλητών.
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ΥΠΟΛΟΓΙΣΜΟΣ ΠΕΡΙΓΡΑΦΙΚΩΝ ΣΤΑΤΙΣΤΙΚΩΝ ΜΕΤΡΩΝ
(ΣΥΝΕΧΕΙΑ)
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ΥΠΟΛΟΓΙΣΜΟΣ ΠΕΡΙΓΡΑΦΙΚΩΝ ΣΤΑΤΙΣΤΙΚΩΝ ΜΕΤΡΩΝ (ΣΥΝΕΧΕΙΑ)

Στους πίνακες µπορούµε να αλλάξουµε τις τιµές, χωρίς να ξαναγίνουν 
υπολογισµοί, τις ετικέτες, να εναλλάξουµε τις γραµµές µε τις στήλες (Pivot →
Transpose Rows and Columns), να αλλάξουµε τις γραµµατοσειρές (Format →
Font) κλπ.

Μπορούµε επίσης να µεταφέρουµε οποιοδήποτε αποτέλεσµα  µε Αντιγραφή και 
Επικόλληση στο Word ή σε οποιοδήποτε άλλο πρόγραµµα.
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ΥΠΟΛΟΓΙΣΜΟΣ ΚΑΙ ΓΡΑΦΙΚΗ ΠΑΡΑΣΤΑΣΗ ΣΥΧΝΟΤΗΤΩΝ, 
ΣΧΕΤΙΚΩΝ ΣΥΧΝΟΤΗΤΩΝ

Μπορούµε µε το SPSS να πάρουµε πίνακες µε τις συχνότητες και τις 
σχετικές συχνότητες των διαφόρων τιµών µιας ή περισσοτέρων 
µεταβλητών. 

Από το µενού επιλέγουµε: Analyze → Descriptive Statistics → Frequencies 

Μπορούµε µέσω της διαδικασίας αυτής να πάρουµε, από το µενού 
Statistics, τιµές διαφόρων στατιστικών µέτρων όπως µέση τιµή (mean), 
τυπική απόκλιση (standard deviation), διασπορά (variance) κλπ για µία ή 
περισσότερες µεταβλητές. 

Μπορούµε επίσης να πάρουµε, από το µενού Charts, γραφήµατα, όπως 
ιστόγραµµατα (histograms), ραβδογράµµατα (bar charts), κυκλικά 
διαγράµµατα (pie charts) κλπ για µία ή περισσότερες µεταβλητές.
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ΥΠΟΛΟΓΙΣΜΟΣ ΚΑΙ ΓΡΑΦΙΚΗ ΠΑΡΑΣΤΑΣΗ ΣΥΧΝΟΤΗΤΩΝ, ΣΧΕΤΙΚΩΝ
ΣΥΧΝΟΤΗΤΩΝ (ΣΥΝΕΧΕΙΑ)
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ΥΠΟΛΟΓΙΣΜΟΣ ΚΑΙ ΓΡΑΦΙΚΗ ΠΑΡΑΣΤΑΣΗ ΣΥΧΝΟΤΗΤΩΝ, ΣΧΕΤΙΚΩΝ
ΣΥΧΝΟΤΗΤΩΝ (ΣΥΝΕΧΕΙΑ)
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ΥΠΟΛΟΓΙΣΜΟΣ ΚΑΙ ΓΡΑΦΙΚΗ ΠΑΡΑΣΤΑΣΗ ΣΥΧΝΟΤΗΤΩΝ, ΣΧΕΤΙΚΩΝ
ΣΥΧΝΟΤΗΤΩΝ (ΣΥΝΕΧΕΙΑ)
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ΥΠΟΛΟΓΙΣΜΟΣ ΚΑΙ ΓΡΑΦΙΚΗ ΠΑΡΑΣΤΑΣΗ ΣΥΧΝΟΤΗΤΩΝ, ΣΧΕΤΙΚΩΝ
ΣΥΧΝΟΤΗΤΩΝ (ΣΥΝΕΧΕΙΑ)
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ΠΙΝΑΚΕΣ ΣΥΝΑΦΕΙΕΣ (CROSSTABULATION)

Με τη διαδικασία Analyze → Crosstabs λαµβάνουµε δυσδιάστατους ή 
πολυδιάστατους πίνακες που εκφράζουν την συνάφεια δύο ή περισσοτέρων 
µεταβλητών.
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ΠΙΝΑΚΕΣ ΣΥΝΑΦΕΙΕΣ (CROSSTABULATION)

Παράλληλα µπορούν να επιλεγούν, από το µενού Statistics, στατιστικοί 
έλεγχοι, όπως το κριτήριο X2, το κριτήριο McNemar κλπ.
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Χρησιµοποιώντας το SPSS µπορούµε να παράγουµε πολλών ειδών 
γραφήµατα, µέσω του µενού: Charts → Interactive

Για παράδειγµα 
από το µενού 
επιλέγουµε: 

Charts →
Interactive →
BoxPlot

ΓΡΑΦΗΜΑΤΑ (ΣΥΝΕΧΕΙΑ)
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ΣΤΑΤΙΣΤΙΚΑ ΤΕΣΤ – ΕΛΕΓΧΟΙ ΥΠΟΘΕΣΕΩΝ

Ένα στατιστικό τέστ ή έλεγχος υποθέσεων αποτελείται από τα εξής 
στοιχεία:

1) Μία στατιστική συνάρτηση Σ (Χ2, t, F, …)

2) ∆ύο υποθέσεις, ειδικότερα:

τη µηδενική υπόθεση Ηο (το ερώτηµα που θέτουµε για να πάρουµε 
απάντηση) και 

την εναλλακτική υπόθεση Η1 (το αντίθετο από το ερώτηµα που θέτουµε).

Το επίπεδο σηµαντικότητας (significance level) είναι:

Ρ (να απορρίψουµε την Ηο / Ηο αληθής) ≤ α 

∆ηλαδή είναι η µέγιστη τιµή της πιθανότητα σφάλµατος που γίνεται κατά 
την απόρριψη της µηδενικής υπόθεσης όταν η µηδενική είναι αληθής. 

Το επίπεδο σηµαντικότητας είναι ένας αριθµός µεταξύ του 0 και του 1. 

Συνήθως επιλέγουµε επίπεδο σηµαντικότητας α = 5 % = 0.05 ή α = 1 % = 
0.01 .
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ΣΤΑΤΙΣΤΙΚΑ ΤΕΣΤ – ΕΛΕΓΧΟΙ ΥΠΟΘΕΣΕΩΝ

Η τιµή p–value (significance value – sig. value) του στατιστικού τεστ 
είναι:

p–value = η πιθανότητα να εµφανιστεί ένα τόσο ή ακόµη και 
πιο «ακραίο» δείγµα από αυτό που εµφανίστηκε, δεδοµένου ότι 
ισχύει η Η0

Η τιµή p–value υπολογίζεται από το SPSS και ερµηνεύεται ως εξής:

Αν p–value < α, τότε η µηδενική υπόθεση Ηο απορρίπτεται και το τεστ 
είναι στατιστικά σηµαντικό.

Αν p–value ≥ α, τότε δεν µπορούµε να απορρίψουµε τη µηδενική 
υπόθεση Ηο.

Αν και από τη θεωρία όταν το p–value είναι ίσο µε α, δεν µπορούµε να 
απορρίψουµε τη µηδενική υπόθεση, 

στην πράξη όταν το p–value είναι περίπου ίσο µε α, σηµειώνουµε ότι 
δεν µπορούµε να διατυπώσουµε ένα ασφαλές συµπέρασµα.

(Κορρές, 2007,  Τσάντας, Μωϋσιάδης, Μπαγιάτης & Χατζηπαντελής, 
1999)
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ΜΗ ΠΑΡΑΜΕΤΡΙΚΑ ΚΡΙΤΗΡΙΑ (ΝΟΝ PARAMETRIC TESTS)

Τα µη παραµετρικά κριτήρια (non parametric tests) εφαρµόζονται κυρίως 
στην περίπτωση ποιοτικών µεταβλητών, αλλά και στην περίπτωση ποσοτικών 
µεταβλητών. 

Η εφαρµογή µη παραµετρικών τεχνικών σε ανεξάρτητα δείγµατα, δεν απαιτεί 
την ύπαρξη κανονικής κατανοµής στον πληθυσµό από τον οποίο προέρχονται 
τα δείγµατα, αντίθετα µε τα παραµετρικά κριτήρια. 

Επίσης δεν υπάρχει περιορισµός ως προς το µέγεθος των δειγµάτων. 

Τα πιο γνωστά µη παραµετρικά κριτήρια είναι: Χ2 – Έλεγχος οµοιογένειας, 
Χ2 – Έλεγχος ανεξαρτησίας, το κριτήριο Mann – Whitney και το κριτήριο 
Kruskal – Wallis.   

Τα αποτελέσµατα της σχέσης µεταξύ υποπληθυσµών ή µεταβλητών 
διερευνώνται εκτενέστερα µέσω των πινάκων συνάφειας (Contingency 
tables), οι οποίοι µπορούν να υπολογιστούν από το SPSS.  

Παρακάτω στα µη παραµετρικά κριτήρια, παρουσιάζουµε παραδείγµατα από 
αποτελέσµατα της έρευνας Κορρές (2006) και Κορρές & Καραστάθης (2007).
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X2–ΕΛΕΓΧΟΣ ΟΜΟΙΟΓΕΝΕΙΑΣ (X2–TESTING FOR

HOMOGENEITY)

Ο έλεγχος X2–Έλεγχος οµοιογένειας (X2–Testing for homogeneity) 
ελέγχει δύο υποπληθυσµούς αναφορικά µε ένα κοινό χαρακτηριστικό 
τους (δηλαδή µία µεταβλητή) και διατυπώνει ένα συµπέρασµα αν 
αυτοί είναι οµοιογενείς, δηλαδή αν µπορούν να θεωρηθούν υποσύνολα 
του ίδιου πληθυσµού.

Η µηδενική υπόθεση Ηο αυτού του ελέγχου είναι ότι οι δύο 
υποπληθυσµοί είναι οµοιογενείς.  

Επιλέγουµε από το µενού:

Analyze → Descriptive statistics → Crosstabs

και επιλέγουµε στο Statistics το Ghi-square.   

Για να είναι αξιόπιστα τα συµπεράσµατα του ελέγχου X2, θα πρέπει 
µέχρι το 20% των κελιών του πίνακα συνάφειας να έχει αναµενόµενη 
συχνότητα κάτω από 5. Αν αυτό δεν συµβεί θα πρέπει να 
συγχωνευθούν είτε γραµµές είτε στήλες του πίνακα συνάφειας µέχρι 
να πετύχουµε τον κανόνα.
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X2–ΕΛΕΓΧΟΣ ΟΜΟΙΟΓΕΝΕΙΑΣ (X2–TESTING FOR

HOMOGENEITY) (ΣΥΝΕΧΕΙΑ)
Στο παρακάτω παράδειγµα, ελέγχεται η οµοιογένεια των υποπληθυσµών 
Αγοριών – Κοριτσιών ως προς το ενδιαφέρον τους στη χρήση Η/Υ.

Από τα αποτελέσµατα του X2–Ελέγχου οµοιογένειας, προέκυψε:

X2 =4.435 µε τιµή p–value = Sig (2–tailed) = 0.218

Εποµένως αφού p–value = 0.218 > α = 0.05 = 5 %, παρατηρούµε ότι σε 
επίπεδο σηµαντικότητας α = 5 %, δεν µπορούµε να απορρίψουµε τη 
µηδενική υπόθεση, άρα οι υποπληθυσµοί Αγόρια – Κορίτσια είναι 
οµοιογενείς.
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Σας προκαλεί ενδιαφέρον η χρήση του Η/Υ; * Φύλο
Crosstabulation

Count

1 2 3

2 5 7

23 33 56

28 20 48

54 60 114

Καθόλου

Λίγο

Πολύ

Πάρα Πολύ

Σας προκαλεί
ενδιαφέρον η
χρήση του
Η/Υ;

Total

Αγόρι Κορίτσι

Φύλο

Total

Chi-Square Tests

4.435 3 .218

4.487 3 .213

3.892 1 .049

114

Pearson Chi-Square

Likelihood Ratio

Linear-by-Linear
Association

N of Valid Cases

Value df
Asymp. Sig.

(2-sided)

X2–ΕΛΕΓΧΟΣ ΑΝΕΞΑΡΤΗΣΙΑΣ (X2–TESTING FOR

INDEPENDENCY)

Ο έλεγχος X2–Έλεγχος ανεξαρτησίας (X2–Testing for independency) 
ελέγχει έναν πληθυσµό αναφορικά µε δύο χαρακτηριστικά (δηλαδή 
δύο µεταβλητές) και διατυπώνει ένα συµπέρασµα αν οι δύο 
µεταβλητές είναι ανεξάρτητες.

Η µηδενική υπόθεση Ηο αυτού του ελέγχου είναι ότι τα δύο 
χαρακτηριστικά (µεταβλητές) είναι ανεξάρτητα.  

Επιλέγουµε από το µενού:

Analyze → Descriptive statistics → Crosstabs

και επιλέγουµε στο Statistics το Ghi-square .   

Στο παρακάτω παράδειγµα, ελέγχεται η ανεξαρτησία των 
µεταβλητών Ενδιαφέρον τους στη χρήση Η/Υ και Ενδιαφέρον στο 
µάθηµα.

Από τα αποτελέσµατα του X2–Ελέγχου ανεξαρτησίας, προέκυψε:

X2 =7.831 µε τιµή p–value = Sig (2–tailed) = 0.251.
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X2–ΕΛΕΓΧΟΣ ΑΝΕΞΑΡΤΗΣΙΑΣ (X2–TESTING FOR

INDEPENDENCY) (ΣΥΝΕΧΕΙΑ)

Εποµένως αφού p–value = 0.251 > α = 0.05 = 5 %, παρατηρούµε ότι σε 
επίπεδο σηµαντικότητας α = 5 %, δεν µπορούµε να απορρίψουµε τη 
µηδενική υπόθεση, άρα οι µεταβλητές Ενδιαφέρον τους στη χρήση Η/Υ
και Ενδιαφέρον στο µάθηµα είναι ανεξάρτητες.
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Chi-Square Tests

7.831 6 .251

7.620 6 .267

3.716 1 .054

112

Pearson Chi-Square

Likelihood Ratio

Linear-by-Linear
Association

N of Valid Cases

Value df
Asymp. Sig.

(2-sided)

Το µάθηµα προκάλεσε το ενδιαφέρον σας; * Σας προκαλεί ενδιαφέρον η χρήση του Η/Υ;
Crosstabulation

Count

2 2 9 6 19

1 5 36 33 75

0 0 10 8 18

3 7 55 47 112

Λίγο

Πολύ

Πάρα Πολύ

Το µάθηµα προκάλεσε
το ενδιαφέρον σας;

Total

Καθόλου Λίγο Πολύ Πάρα Πολύ

Σας προκαλεί ενδιαφέρον η χρήση του Η/Υ;

Total

ΤΟ ΚΡΙΤΗΡΙΟ MANN – WHITNEY

Το µη παραµετρικό κριτήριο Mann – Whitney (U) εφαρµόζεται όταν 
έχουµε δεδοµένα που µπορούν να διαβαθµιστούν, χωρίς την υπόθεση 
ότι ακολουθούν την κανονική κατανοµή. 

Η µέθοδος συγκρίνει δύο ανεξάρτητα δείγµατα για το αν 
παρουσιάζουν διαφορές στις κατανοµές τους. 

Η µηδενική υπόθεση (Ho) στο κριτήριο αυτό είναι ότι τα δύο δείγµατα 
είναι υποσύνολα πληθυσµών µε την ίδια συνάρτηση κατανοµής 
(distribution function). 

Η εναλλακτική υπόθεση (H1) είναι είτε ότι οι συναρτήσεις κατανοµών 
είναι στοχαστικά διατεταγµένες (stochastically ordered) ή ότι είναι 
άνισες.

Επιλέγουµε από το µενού:

Analyze → Non parametric tests → Two independent samples

και επιλέγουµε στο Test type το τεστ Mann–Whitney U.   
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ΤΟ ΚΡΙΤΗΡΙΟ MANN – WHITNEY (ΣΥΝΕΧΕΙΑ)
Στο παρακάτω παράδειγµα, ελέγχεται αν οι υποπληθυσµοί Αγόρια – Κορίτσια 
είναι υποσύνολα πληθυσµών µε την ίδια συνάρτηση κατανοµής ως προς το 
ενδιαφέρον τους στη χρήση Η/Υ.

Από τα αποτελέσµατα του Mann – Whitney test, προέκυψε:

U = 1289.5 µε τιµή p–value = Sig (2–tailed) = 0.037

Εποµένως σε επίπεδο σηµαντικότητας α = 1 % = 0.01  δεν µπορούµε να 
απορρίψουµε τη µηδενική υπόθεση, 

ενώ σε επίπεδο σηµαντικότητας α = 5 % = 0.05 η µηδενική υπόθεση Ηο

απορρίπτεται και το τεστ είναι στατιστικά σηµαντικό.
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Test Statisticsa

1289.500

3119.500

-2.088

.037

Mann-Whitney U

Wilcoxon W

Z

Asymp. Sig. (2-tailed)

Σας προκαλεί
ενδιαφέρον η
χρήση του

Η/Υ;

Grouping Variable: Φύλοa. 

ΤΟ ΚΡΙΤΗΡΙΟ KRUSKAL–WALLIS

Το µη παραµετρικό κριτήριο Kruskal–Wallis (H) συγκρίνει τρία ή 
περισσότερα ανεξάρτητα δείγµατα για το αν παρουσιάζουν διαφορές 
στις κατανοµές τους. 

Η µέθοδος αποτελεί γενίκευση του κριτηρίου Mann – Whitney και 
εφαρµόζεται όταν έχουµε δεδοµένα που µπορούν να διαβαθµιστούν, 
χωρίς την υπόθεση ότι ακολουθούν την κανονική κατανοµή. 

Η µηδενική υπόθεση (Ho) στο κριτήριο αυτό είναι ότι τα τρία ή 
περισσότερα δείγµατα είναι υποσύνολα πληθυσµών µε την ίδια 
συνάρτηση κατανοµής (distribution function). 

Επιλέγουµε από το µενού:

Analyze → Non parametric tests → K independent samples

και επιλέγουµε στο Test type το τεστ Kruskal – Wallis H.   
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ΤΟ ΚΡΙΤΗΡΙΟ KRUSKAL–WALLIS

Στο παρακάτω παράδειγµα, ελέγχεται αν οι υποπληθυσµοί Τµήµα 1, Τµήµα 2, 
Τµήµα 3, Τµήµα 4 και Τµήµα 5 είναι υποσύνολα πληθυσµών µε την ίδια 
συνάρτηση κατανοµής ως προς το ενδιαφέρον τους στη χρήση Η/Υ.

Από τα αποτελέσµατα του Kruskal – Wallis test, προέκυψε:

H = 3.148 µε τιµή p–value = Sig (2–tailed) = 0.533

Εποµένως σε επίπεδο σηµαντικότητας α = 5 % = 0.05 δεν µπορούµε να 
απορρίψουµε τη µηδενική υπόθεση.
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Test Statisticsa,b

3.148

4

.533

Chi-Square

df

Asymp. Sig.

Σας προκαλεί
ενδιαφέρον η χρήση

του Η/Υ;

Kruskal Wallis Testa. 

Grouping Variable: Τµήµαb. 

ΠΑΡΑΜΕΤΡΙΚΑ ΚΡΙΤΗΡΙΑ (PARAMETRIC TESTS)

Τα παραµετρικά κριτήρια εφαρµόζονται στην περίπτωση ποσοτικών 
µεταβλητών. 

Η εφαρµογή παραµετρικών τεχνικών σε ανεξάρτητα δείγµατα, 
απαιτεί την ύπαρξη της κανονικής κατανοµής στον πληθυσµό από 
τον οποίο προέρχονται τα δείγµατα. 

Εναλλακτικά, επιτρέπεται η χρήση τους όταν τα µεγέθη των 
δειγµάτων είναι αρκετά µεγάλα (≥ 30), διότι τότε το Κεντρικό 
Οριακό Θεώρηµα της θεωρίας Πιθανοτήτων εξασφαλίζει την 
ικανοποίηση των προϋποθέσεων.

Ακόµα και αν πληρούνται οι προϋποθέσεις εφαρµογής των 
παραµετρικών κριτηρίων, µπορούµε να πραγµατοποιήσουµε και µη 
παραµετρικές αναλύσεις. 

(Κορρές, 2007, Τσάντας, Μωϋσιάδης, Μπαγιάτης & Χατζηπαντελής, 
1999) 
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ΤΟ ΚΡΙΤΗΡΙΟ T–TEST ΓΙΑ ΤΟΝ ΕΛΕΓΧΟ ΙΣΟΤΗΤΑΣ ΤΩΝ

ΜΕΣΩΝ ∆ΥΟ ΑΝΕΞΑΡΤΗΤΩΝ ∆ΕΙΓΜΑΤΩΝ

Το παραµετρικό κριτήριο t–test, για τον έλεγχο της ισότητας των µέσων δύο 
ανεξάρτητων δειγµάτων (Independent Samples t-test), αναφέρεται στη 
σύγκριση της µέσης τιµής ενός χαρακτηριστικού – µεταβλητής για δύο 
ανεξάρτητα δείγµατα. 

Η µηδενική υπόθεση (Ho) του κριτηρίου είναι ότι η διαφορά µεταξύ των δύο 
µέσων όρων είναι µηδενική.

Σε κάθε περίπτωση, ελέγχουµε αν οι πληθυσµοί είναι οµοιογενείς ή όχι 
κάνοντας έλεγχο ισότητας των διακυµάνσεων, µέσω του Levene’s test for 
Equality of Variances. 

Το SPSS κάνει τους ελέγχους ισότητας των διακυµάνσεων (Levene’s test)
και ισότητας των µέσων (t– test) απευθείας σε όλες τις περιπτώσεις, 

ΕΚΤΟΣ των ανισοπληθών δειγµάτων που προέρχονται από ανοµοιογενείς 
πληθυσµούς, όπου χρειάζεται η διόρθωση Cochran & Cox στις t – κρίσιµες 
τιµές. 

(Κορρές, 2007, Παρασκευόπουλος, 1990, 1993γ)
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ΤΟ ΚΡΙΤΗΡΙΟ T–TEST ΓΙΑ ΤΟΝ ΕΛΕΓΧΟ ΙΣΟΤΗΤΑΣ ΤΩΝ

ΜΕΣΩΝ ∆ΥΟ ΑΝΕΞΑΡΤΗΤΩΝ ∆ΕΙΓΜΑΤΩΝ (ΣΥΝΕΧΕΙΑ)

Για παράδειγµα, αν θέλουµε να ελέγξουµε την αποτελεσµατικότητα µίας 
διδακτικής προσέγγισης, µπορούµε να χρησιµοποιήσουµε την πειραµατική 
µέθοδο, σύµφωνα µε την οποία εφαρµόζουµε τη διδακτική προσέγγιση σε µία 
οµάδα φοιτητών ή µαθητών (Πειραµατική οµάδα), ενώ έχουµε άλλη µία 
οµάδα φοιτητών ή µαθητών στη οποία εφαρµόζουµε µία παραδοσιακή 
προσέγγιση (Οµάδα ελέγχου).  

Στη συνέχεια συγκρίνουµε τη µέση επίδοση των δύο οµάδων φοιτητών ή 
µαθητών, αρχικά ως προς την επίδοση τους σε ένα προ – τεστ, πριν την 
εφαρµογή του διαφοροποιηµένου προγράµµατος διδασκαλίας και στη 
συνέχεια ως προς την επίδοση τους σε ένα µετά – τεστ, µετά την εφαρµογή 
του διαφοροποιηµένου προγράµµατος.

Η νέα προσέγγιση µπορεί να θεωρηθεί αποτελεσµατικότερη της 
παραδοσιακής, αν προκύψει διαφορά στη µέση επίδοση των φοιτητών ή 
µαθητών στο µετά – τεστ, ενώ δεν προκύψει διαφορά στη µέση επίδοση τους 
στο προ – τεστ.  

Παρακάτω παρουσιάζουµε ένα παράδειγµα από αποτελέσµατα της έρευνας    

Korres & Kyriazis (2010).
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ΤΟ ΚΡΙΤΗΡΙΟ T–TEST ΓΙΑ ΤΟΝ ΕΛΕΓΧΟ ΙΣΟΤΗΤΑΣ ΤΩΝ

ΜΕΣΩΝ ∆ΥΟ ΑΝΕΞΑΡΤΗΤΩΝ ∆ΕΙΓΜΑΤΩΝ (ΣΥΝΕΧΕΙΑ)

Από το µενού επιλέγουµε: 

Analyze → Compare means → Independent Samples t – test 

όπου εισάγουµε στο πεδίο Test variable(s) την επίδοση στο προ – τεστ και 
την επίδοση στο µετά – τεστ και στο πεδίο Grouping variable τη 
µεταβλητή που αναφέρεται στις δύο οµάδες.  

Μία ένδειξη για την ισότητα των µέσων των οµάδων έχουµε από τα 
περιγραφικά µέτρα, δηλαδή :  
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ΤΟ ΚΡΙΤΗΡΙΟ T–TEST ΓΙΑ ΤΟΝ ΕΛΕΓΧΟ ΙΣΟΤΗΤΑΣ ΤΩΝ

ΜΕΣΩΝ ∆ΥΟ ΑΝΕΞΑΡΤΗΤΩΝ ∆ΕΙΓΜΑΤΩΝ (ΣΥΝΕΧΕΙΑ)

Από τον παρακάτω πίνακα αποτελεσµάτων του SPSS ως προς την επίδοση στο 
προ – τεστ, 

προκύπτει ότι ο έλεγχος της ισότητας των δύο διακυµάνσεων (Levene’s test for 
Equality of Variances) έδωσε F = 0,319 και p–value = 0,573, 

οπότε δεν µπορούµε να προχωρήσουµε στην απόρριψη της.

Εποµένως θα χρησιµοποιήσουµε το t–test που αντιστοιχεί στην περίπτωση των 
ίσων διακυµάνσεων (Equal variances assumed). 

Από τα αποτελέσµατα του t – test έχουµε t = – 0,052, df = 102, p–value = 
0,958, οπότε παρατηρούµε ότι δεν µπορούµε να απορρίψουµε τη µηδενική 
υπόθεση ότι δεν υπάρχει διαφορά στη µέση επίδοση των φοιτητών των δύο 
οµάδων.      
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Independent Samples Test

.319 .573 -.052 102 .958 -.018 .347

-.052 100.877 .958 -.018 .347

Equal variances
assumed

Equal variances
not assumed

Βαθµός επίδοσης
στο προ-τεστ

F Sig.

Levene's Test for
Equality of Variances

t df Sig. (2-tailed)
Mean

Difference
Std. Error
Difference

t-test for Equality of Means



ΤΟ ΚΡΙΤΗΡΙΟ T–TEST ΓΙΑ ΤΟΝ ΕΛΕΓΧΟ ΙΣΟΤΗΤΑΣ ΤΩΝ

ΜΕΣΩΝ ∆ΥΟ ΑΝΕΞΑΡΤΗΤΩΝ ∆ΕΙΓΜΑΤΩΝ (ΣΥΝΕΧΕΙΑ)

Ως προς την επίδοση στο µετά – τεστ, 

προκύπτει ότι ο έλεγχος της ισότητας των δύο διακυµάνσεων (Levene’s test for 
Equality of Variances) έδωσε F = 0,630 και p–value = 0,429, 

οπότε παρατηρούµε ότι δεν µπορούµε να προχωρήσουµε στην απόρριψη της.

Εποµένως θα χρησιµοποιήσουµε το t–test που αντιστοιχεί στην περίπτωση των 
ίσων διακυµάνσεων (Equal variances assumed). 

Από τα αποτελέσµατα του t – test έχουµε t = 7,360, df = 102, p–value < 0,001, 
οπότε παρατηρούµε ότι υπάρχει στατιστικά σηµαντική διαφορά στη µέση 
επίδοση των φοιτητών των δύο οµάδων.      
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Independent Samples Test

.630 .429 7.360 102 .000 2.724 .370

7.352 101.113 .000 2.724 .371

Equal variances
assumed

Equal variances
not assumed

Βαθµός επίδοσης
στο µετα-τεστ

F Sig.

Levene's Test for
Equality of Variances

t df Sig. (2-tailed)
Mean

Difference
Std. Error
Difference

t-test for Equality of Means

ΤΟ ΚΡΙΤΗΡΙΟ T–TEST ΓΙΑ ΤΟΝ ΕΛΕΓΧΟ ΤΗΣ ∆ΙΑΦΟΡΑΣ

ΤΩΝ ΜΕΣΩΝ ΓΙΑ ΖΕΥΓΑΡΩΤΕΣ ΠΑΡΑΤΗΡΗΣΕΙΣ

Το παραµετρικό κριτήριο t–test, για τον έλεγχο της διαφοράς των µέσων για 
ζευγαρωτές παρατηρήσεις (Paired Samples t-test), αναφέρεται στη 
σύγκριση δύο χαρακτηριστικών – µεταβλητών για το ίδιο δείγµα οι οποίες 
αναφέρονται συνήθως σε µετρήσεις του ίδιου χαρακτηριστικού πριν και 
µετά από την πραγµατοποίηση κάποιου φαινοµένου.   

Για παράδειγµα, µπορούµε στην ίδια οµάδα φοιτητών ή µαθητών, να 
συγκρίνουµε τη µέση επίδοση τους, πριν και µετά την εφαρµογή µίας 
διδακτικής προσέγγισης.    

Η µηδενική υπόθεση (Ho) του κριτηρίου είναι ότι η διαφορά µεταξύ των δύο 
µέσων όρων είναι µηδενική.

Το t–test για τον έλεγχο της διαφοράς των µέσων για ζευγαρωτές 
παρατηρήσεις, έχει ως προϋπόθεση οι διαφορές µεταξύ των τιµών των δύο 
µεταβλητών να προέρχονται από πληθυσµό ο οποίος ακολουθεί την κανονική 
κατανοµή. 
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ΤΟ ΚΡΙΤΗΡΙΟ T–TEST ΓΙΑ ΤΟΝ ΕΛΕΓΧΟ ΤΗΣ ∆ΙΑΦΟΡΑΣ

ΤΩΝ ΜΕΣΩΝ ΓΙΑ ΖΕΥΓΑΡΩΤΕΣ ΠΑΡΑΤΗΡΗΣΕΙΣ (ΣΥΝΕΧΕΙΑ)

Για παράδειγµα, αν θέλουµε να ελέγξουµε την αποτελεσµατικότητα µίας 
διδακτικής προσέγγισης, µπορούµε να χρησιµοποιήσουµε µία οµάδα φοιτητών 
ή µαθητών και στη συνέχεια να συγκρίνουµε τη µέση επίδοση τους σε ένα προ –
τεστ, πριν την εφαρµογή του προγράµµατος διδασκαλίας και σε ένα µετά –
τεστ, µετά την εφαρµογή του προγράµµατος.

Η νέα προσέγγιση µπορεί να θεωρηθεί αποτελεσµατική, αν προκύψει διαφορά 
µεταξύ της µέσης επίδοσης των φοιτητών ή µαθητών στο µετά – τεστ και στο 
προ – τεστ.    

Παρακάτω παρουσιάζουµε ένα παράδειγµα από αποτελέσµατα της έρευνας    

Kyriazis, Psycharis & Korres (2009).

Από το µενού επιλέγουµε: 

Analyze → Compare means → Paired Samples t – test 

όπου εισάγουµε στο πεδίο Paired variables την επίδοση στο προ – τεστ και την 
επίδοση στο µετά – τεστ.  
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ΤΟ ΚΡΙΤΗΡΙΟ T–TEST ΓΙΑ ΤΟΝ ΕΛΕΓΧΟ ΤΗΣ ∆ΙΑΦΟΡΑΣ ΤΩΝ

ΜΕΣΩΝ ΓΙΑ ΖΕΥΓΑΡΩΤΕΣ ΠΑΡΑΤΗΡΗΣΕΙΣ (ΣΥΝΕΧΕΙΑ)

Αρχικά ελέγχουµε αν οι διαφορές µεταξύ των τιµών των δύο µεταβλητών 
προέρχονται από πληθυσµό ο οποίος ακολουθεί την κανονική κατανοµή.

Ορίζουµε τη µεταβλητή: di = Score(post) – Score(pre)

επιλέγοντας από το µενού: Transform → Compute variable

Στο πεδίο Target variable εισάγουµε: di και στο πεδίο Numeric expression 
εισάγουµε: Score(post) – Score(pre)

Έπειτα  εφαρµόζουµε το τεστ One Sample Kolmogorov–Smirnov test για τις 
διαφορές των τιµών των δύο µεταβλητών: 

Analyze → Nonparametric tests → One-Sample Kolmogorov-Smirnov Test

Από τον πίνακα αποτελεσµάτων του SPSS  προκύπτει: 

Z = 0.753, p = 0.622, 

οπότε ικανοποιείται η προϋπόθεση του t–test για τον έλεγχο της διαφοράς των 
µέσων για ζευγαρωτές παρατηρήσεις.
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One-Sample Kolmogorov-Smirnov Test

.753

.622

Kolmogorov-Smirnov Z

Asymp. Sig. (2-tailed)

di



ΤΟ ΚΡΙΤΗΡΙΟ T–TEST ΓΙΑ ΤΟΝ ΕΛΕΓΧΟ ΤΗΣ ∆ΙΑΦΟΡΑΣ

ΤΩΝ ΜΕΣΩΝ ΓΙΑ ΖΕΥΓΑΡΩΤΕΣ ΠΑΡΑΤΗΡΗΣΕΙΣ (ΣΥΝΕΧΕΙΑ)

Τα αποτελέσµατα του t–test για τον έλεγχο της διαφοράς των µέσων για 
ζευγαρωτές παρατηρήσεις µας δίνουν το συντελεστή συσχέτισης του Pearson και 
περιγραφικά µέτρα για τις δύο µεταβλητές. 

Ειδικότερα από τον πίνακα αποτελεσµάτων του SPSS προκύπτει: 

r = 0.820 και p – value < 0.001, 

οπότε προκύπτει µία ισχυρή γραµµική συσχέτιση µεταξύ των δύο µεταβλητών. 
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Paired Samples Correlations

20 .820 .000Score(pre) & Score(post)Pair 1
N Correlation Sig.

Paired Samples Statistics

3.350 20 2.7961 .6252

6.150 20 2.4767 .5538

Score(pre)

Score(post)

Pair
1

Mean N Std. Deviation
Std. Error

Mean

ΤΟ ΚΡΙΤΗΡΙΟ T–TEST ΓΙΑ ΤΟΝ ΕΛΕΓΧΟ ΤΗΣ ∆ΙΑΦΟΡΑΣ

ΤΩΝ ΜΕΣΩΝ ΓΙΑ ΖΕΥΓΑΡΩΤΕΣ ΠΑΡΑΤΗΡΗΣΕΙΣ (ΣΥΝΕΧΕΙΑ) 

Από τον πίνακα αποτελεσµάτων του SPSS προκύπτει ότι η µέση τιµή των 
διαφορών µεταξύ των επιδόσεων των φοιτητών ισούται µε –2.8, µε το 
αντίστοιχο διάστηµα εµπιστοσύνης  95% να είναι από –3.55 έως –2.05. 

Εφόσον το διάστηµα εµπιστοσύνης δεν περιέχει την τιµή 0, υπάρχει διαφορά 
µεταξύ των µέσων επιδόσεων των φοιτητών µε πιθανότητα σφάλµατος 0.05. 

Τα αποτελέσµατα του t–test είναι: t = –7.782, df = 19, p < 0.01, 

µε το αρνητικό πρόσηµο να δείχνει ότι η µέση τιµή της επίδοσης των φοιτητών 
πριν την προσέγγιση είναι µικρότερη από την επίδοση των φοιτητών µετά την 
προσέγγιση.
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Paired Samples Test

-2.8000 1.6092 .3598 -3.5531 -2.0469 -7.782 19 .000Score(pre) - Score(post)Pair 1
Mean Std. Deviation

Std. Error
Mean Lower Upper

95% Confidence
Interval of the

Difference

Paired Differences

t df Sig. (2-tailed)



ΑΠΛH ΓΡΑMMIKH ΠΑΛΙΝ∆ΡOMΗΣΗ (SIMPLE LINEAR

REGRESSION)

Η απλή γραµµική παλινδρόµηση (Simple Linear Regression) 
µελετάει τη  σχέση µεταξύ δυο ποσοτικών µεταβλητών Χ, Υ. 

Από έναν πληθυσµό παίρνουµε ένα δείγµα µεγέθους n και για κάθε 
άτοµο του δείγµατος καταγράφουµε τις τιµές δύο µεταβλητών Χ, Υ, 
δηλαδή ζεύγη τιµών (Χ1,Υ1), (X2,Υ2), …, (Xn,Υn).

Η απλή γραµµική παλινδρόµηση ελέγχει κατά πόσο τα σηµεία 
(Xi,Yi) µπορούν να θεωρηθούν σηµεία µιας ευθείας: 

y = b0 + b1x, i = 1, 2, …, n 

για κάποιες σταθερές b0, b1.

Η µεταβλητή X η οποία καλείται ανεξάρτητη (independent).

Η µεταβλητή Y η οποία καλείται εξαρτηµένη (dependent).
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ΑΠΛH ΓΡΑMMIKH ΠΑΛΙΝ∆ΡOMΗΣΗ (SIMPLE LINEAR

REGRESSION) (ΣΥΝΕΧΕΙΑ)

Παρακάτω παρουσιάζουµε ένα παράδειγµα από αποτελέσµατα της έρευνας    

Kyriazis, Psycharis & Korres (2009).

Αν θέλουµε να µελετήσουµε τη σχέση µεταξύ των µεταβλητών Επίδοση στο 
µετά – τεστ (Υ) (εξαρτηµένη) και Επίδοση στο προ – τεστ (Χ) (ανεξάρτητη).

Από το µενού επιλέγουµε: 

Analyze → Regression → Linear

όπου εισάγουµε στο πεδίο Dependent την επίδοση στο µετά – τεστ 
(Score(post)) και στο πεδίο Independent την επίδοση στο προ – τεστ
(Score(pre)). 

Στο πεδίο Statistics επιλέγουµε Estimates, Confidence intervals και Model fit.

Εναλλακτικά, από το µενού επιλέγουµε: 

Analyze → Regression → Curve estimation 

όπου εισάγουµε τις µεταβλητές όπως προηγουµένως. 

Στο πεδίο Models επιλέγουµε Linear, επιπλέον επιλέγουµε Include constant 
in equation, Plot Models και Display ANOVA Table.
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ΑΠΛH ΓΡΑMMIKH ΠΑΛΙΝ∆ΡOMΗΣΗ (SIMPLE LINEAR

REGRESSION) (ΣΥΝΕΧΕΙΑ)
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ΑΠΛH ΓΡΑMMIKH ΠΑΛΙΝ∆ΡOMΗΣΗ (SIMPLE LINEAR

REGRESSION) (ΣΥΝΕΧΕΙΑ)

Από τα αποτελέσµατα της στατιστικής ανάλυσης, οι εκτιµήσεις των 
b0, b1 είναι 3.716 και 0.727 αντίστοιχα, ενώ τα αντίστοιχα δ.ε. είναι 
(2.633, 4.799) και (0.476, 0.977).

Το p-value για τους δυο αυτούς ελέγχους είναι σχεδόν 0 και
εποµένως απορρίπτουµε τις υποθέσεις:

b0 = 0 (t – test, t= 7.207, p-value < 0.01)

b1 = 0 (t – test, t= 6.088, p-value < 0.01).

Άρα η µεταβλητή Score(post) εξαρτάται από την Score(pre), εφόσον 
αν προέκυπτε b1 = 0 τότε η µεταβλητή Score(post) θα ήταν 
ανεξάρτητη της Score(pre).

46

Κ
ο
ρ
ρ
ές Κ

. (2
0

1
2

). Μ
έθ
ο
δ
ο
ι σ
τα
τισ

τική
ς α

νά
λυσ

η
ς µ

ε τη
 

β
ο
ή
θ
εια

 το
υ S

P
S

S
. Α

.Σ
.Π
Α
Ι.Τ

.Ε
. 

Coefficientsa

3.716 .516 7.207 .000 2.633 4.799

.727 .119 .820 6.088 .000 .476 .977

(Constant)

Score(pre)

Model
1

B Std. Error

Unstandardized
Coefficients

Beta

Standardized
Coefficients

t Sig. Lower Bound Upper Bound

95% Confidence Interval for B

Dependent Variable: Score(post)a. 



ΑΠΛH ΓΡΑMMIKH ΠΑΛΙΝ∆ΡOMΗΣΗ (SIMPLE LINEAR

REGRESSION) (ΣΥΝΕΧΕΙΑ)

Ο πίνακας ανάλυσης διασποράς (ΑNOVA) δίνεται απευθείας από το SPSS.

Τα αποτελέσµατα του ελέγχου Η0: b1=0, Η1: b1≠0 δίνονται στον πίνακα ANOVA 
και είναι: F = 37.058 και p-value < 0.01

(στο απλό γραµµικό µοντέλο ο έλεγχος της συγκεκριµένης υπόθεσης µέσω της F 
τιµής στον πίνακα ΑΝΟVΑ είναι ισοδύναµος µε τον έλεγχο που γίνεται µέσω
του t-test παραπάνω).

Η εκτίµηση της διασποράς των σφαλµάτων από τον πίνακα ANOVA είναι 
2.117.

Το ποσοστό της µεταβλητότητας των Yi που ερµηνεύεται από το µοντέλο 
δίνεται από το R2 = 0.673.
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Model Summary

.820 .673 .655 1.455
R R Square

Adjusted
R Square

Std. Error of
the Estimate

The independent variable is Score(pre).

ANOVA

78.446 1 78.446 37.058 .000

38.104 18 2.117

116.550 19

Regression

Residual

Total

Sum of
Squares df Mean Square F Sig.

The independent variable is Score(pre).

ΑΠΛH ΓΡΑMMIKH ΠΑΛΙΝ∆ΡOMΗΣΗ (SIMPLE LINEAR

REGRESSION) (ΣΥΝΕΧΕΙΑ)
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Από το µενού επιλέγουµε: 

Graphs → Interactive → ScatterPlots 

Στο πεδίο Assign variables εισάγουµε τις µεταβλητές Score(post) και Score(pre).  

Στο πεδίο Fit επιλέγουµε Method: Regression, Prediction lines: Individual.



ΑΠΛH ΓΡΑMMIKH ΠΑΛΙΝ∆ΡOMΗΣΗ (SIMPLE LINEAR

REGRESSION) (ΣΥΝΕΧΕΙΑ)
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Εποµένως για δεδοµένη τιµή του Score(pre), η εκτίµηση για το Score(post) είναι: 
Score(post) = 3.716 + 0.727 Score(pre)

Για παράδειγµα,  κάποιος φοιτητής που έγραψε στο προ – τεστ βαθµό ίσο µε 7, 
είναι αναµενόµενο στο µετά – τεστ να γράψει:

Score(post) = 3.716 + 0.727 .7 = 8.805

ΒΙΒΛΙΟΓΡΑΦIΑ

Κορρές Κ. (2007). Μία διδακτική προσέγγιση των µαθηµάτων Θετικών 
Επιστηµών µε τη βοήθεια νέων τεχνολογιών. ∆ιδακτορική διατριβή. Τµήµα 
Στατιστικής και Ασφαλιστικής Επιστήµης. Πανεπιστήµιο Πειραιώς.
Cohen L. & Manion L. (2000). Research Methods in Education (4th Edition).
London and New York: Routledge.
Τσάντας Ν., Μωϋσιάδης Χ., Μπαγιάτης Ντ. & Χατζηπαντελής Θ. (1999). 
Ανάλυση δεδοµένων µε τη βοήθεια στατιστικών πακέτων. θεσσαλονίκη: 
Εκδόσεις Ζήτη.
Παρασκευόπουλος Ι. Ν. (1993α). Μεθοδολογία Επιστηµονικής Έρευνας (τ. Α΄). 
Πανεπιστηµιακές Σηµειώσεις. Πανεπιστήµιο Αθηνών. 
Παρασκευόπουλος Ι. Ν. (1993β). Μεθοδολογία Επιστηµονικής Έρευνας (τ. Β΄). 
Πανεπιστηµιακές Σηµειώσεις. Πανεπιστήµιο Αθηνών.
Παρασκευόπουλος Ι. Ν. (1990). Στατιστική: Περιγραφική Στατιστική (τ. Α΄). 
Πανεπιστηµιακές Σηµειώσεις. Πανεπιστήµιο Αθηνών. 
Παρασκευόπουλος Ι. Ν. (1993γ). Στατιστική: Επαγωγική Στατιστική (τ. Β΄). 
Πανεπιστηµιακές Σηµειώσεις. Πανεπιστήµιο Αθηνών. 
∆αµιανού Χ. & Κούτρας Μ. (1993). Εισαγωγή στη Στατιστική (τ. Ι). Αθήνα: 
Εκδόσεις Αίθρα.  
∆αµιανού Χ. & Κούτρας Μ. (1996). Εισαγωγή στη Στατιστική (τ. ΙΙ). Αθήνα: 
Εκδόσεις Συµµετρία.  

50

Κ
ο
ρ
ρ
ές Κ

. (2
0

1
2

). Μ
έθ
ο
δ
ο
ι σ
τα
τισ

τική
ς α

νά
λυσ

η
ς µ

ε τη
 

β
ο
ή
θ
εια

 το
υ S

P
S

S
. Α

.Σ
.Π
Α
Ι.Τ

.Ε
. 



ΒΙΒΛΙΟΓΡΑΦIΑ (ΣΥΝΕΧΕΙΑ)

Korres K. & Kyriazis A. (2010). “Instructional Design using computers as 
cognitive tools in Mathematics and Science Higher Education”. Σύγχρονα 
θέµατα Εκπαίδευσης (Contemporary Issues in Education), Τόµος 1, Τεύχος 1, 
2010, σελ. 43–65. Εκδόσεις Παπαζήση.

Kyriazis A., Psycharis S. & Korres K. (2009). “Discovery Learning and the 
Computational Experiment in Higher Mathematics and Science Education: A 
combined approach”. International Journal of Emerging Technologies in 
Learning (IJET) of the International Association of Online Engineering (IAOE), 
Volume 4, Issue 4, December 2009, p. 25–34.

Κορρές Κ. (2006). Σχεδιασµός δραστηριοτήτων για τη διδασκαλία 
µαθηµατικών εννοιών µε τη χρήση υπερµέσων. Πρακτικά του 23ου
Πανελλήνιου Συνεδρίου Μαθηµατικής Παιδείας µε διεθνή συµµετοχή της 
Ελληνικής Μαθηµατικής Εταιρείας. Πάτρα, 24 – 26 Νοεµβρίου 2006.

Κορρές Κ. & Καραστάθης Π. (2007). ∆ιδασκαλία µαθηµατικών εννοιών µε τη 
βοήθεια υπερµέσων: Στατιστική µελέτη γνώσεων – διαθέσεων µαθητών. 
Πρακτικά του 1ου Πανελλήνιου Συνεδρίου του Συλλόγου Μεταπτυχιακών 
Καθηγητών ∆ευτεροβάθµιας Εκπαίδευσης. Αθήνα, 20 – 21 Απριλίου 2007.

51

Κ
ο
ρ
ρ
ές Κ

. (2
0

1
2

). Μ
έθ
ο
δ
ο
ι σ
τα
τισ

τική
ς α

νά
λυσ

η
ς µ

ε τη
 

β
ο
ή
θ
εια

 το
υ S

P
S

S
. Α

.Σ
.Π
Α
Ι.Τ

.Ε
. 



∆ΟΜΗ ΕΠΙΣΤΗΜΟΝΙΚΗΣ ΕΡΓΑΣΙΑΣ 

∆ρ Κορρές Κωνσταντίνος 
 

Η δοµή της επιστηµονικής εργασίας συνήθως περιέχει: 

 

Σελίδα τίτλων 

 

Περίληψη 

 

1. Εισαγωγή  

 Σύντοµη παράθεση του τι είναι ήδη γνωστό στο γνωστικό αντικείµενο 

 Στόχοι της εργασίας 

 Αναγκαιότητα εκπόνησης της εργασίας 

 Αναφορά σε ερευνητικά ερωτήµατα  

 Σύντοµη περιγραφή του τι περιέχεται στη εργασία ανά ενότητα 

 

2. Ανασκόπηση της βιβλιογραφίας  

 Κυρίως (80%) από papers που έχουν δηµοσιευτεί σε διεθνή ή ελληνικά 

επιστηµονικά περιοδικά µε αναζήτηση στις βάσεις κάποιας ακαδηµαϊκής 

βιβλιοθήκης.  

 ∆ευτερευόντως (20%) από βιβλία που έχουν γραφεί σχετικά.   

Η ανασκόπηση της βιβλιογραφίας συνήθως καταλαµβάνει το 20% - 30% της 

συνολικής έκτασης της εργασίας.   

Γίνεται συσχέτιση και σχολιασµός των συµπερασµάτων και αποτελεσµάτων που 

έχουν αναπτυχθεί στην παράγραφο.  

Αναπτύσσονται και τεκµηριώνονται τα ερευνητικά ερωτήµατα ή ερευνητικές 

υποθέσεις. 

 

3. Η µεθοδολογία της έρευνας  

Αναπτύσσονται και ξεκαθαρίζονται οι επιλεγµένες µέθοδοι έρευνας. 

Αναφέρεται αν πρόκειται για εµπειρική έρευνα ή βιβλιογραφική έρευνα.  

Αναπτύσσονται τα εργαλεία της έρευνας, µε αναφορά σε µεθόδους έρευνας που 

έχουν δηµοσιευτεί στη βιβλιογραφία και σχολιάζονται αναφορικά µε την 



καταλληλότητα τους στη συγκεκριµένη έρευνα και την αποτελεσµατικότητα τους σε 

σχετικές έρευνες.   

 

4. Ανάλυση:  

Πρωτότυπες διδακτικές εφαρµογές και / ή πρωτότυπα αποτελέσµατα έρευνας  

 

Εναλλακτικά ή συµπληρωµατικά µπορούµε να συµπεριλάβουµε:  

 

4Α. Παρουσίαση προτεινόµενων διδακτικών εφαρµογών για τη διδασκαλία 

ενότητας µαθήµατος ειδικότητας, ειδικότερα:  

 Παρουσίαση και σχολιασµός του σχεδιασµού των διδακτικών εφαρµογών 

 Παρουσίαση και σχολιασµός του σχεδιασµού και της υλοποίησης διδακτικού 

υλικού των διδακτικών εφαρµογών 

 Παρουσίαση και συζήτηση αναµενόµενων αποτελεσµάτων των διδακτικών 

εφαρµογών 

 

ή / και 

 

4Β. Παρουσίαση αποτελεσµάτων έρευνας για τη διδασκαλία ενότητας 

µαθήµατος ειδικότητας ή για τη διερεύνηση θέµατος διαθέσεων – στάσεων ή 

προσδοκιών µαθητών ή σπουδαστών σχετικά µε κάποιο θέµα εκπαίδευσης, 

ειδικότερα:  

 Παρουσίαση και σχολιασµός του σχεδιασµού της έρευνας 

 Παρουσίαση και σχολιασµός της υλοποίησης της έρευνας και  

 Παρουσίαση και συζήτηση των αποτελεσµάτων της έρευνας, 

συµπεριλαµβανοµένων των αποτελεσµάτων της στατιστικής ανάλυσης   

 

5. Αξιολόγηση 

Συζήτηση, συσχετισµός και διερεύνηση των αποτελεσµάτων της έρευνας συγκριτικά 

µε αποτελέσµατα και συµπεράσµατα από την ανασκόπηση της βιβλιογραφίας  

 

6. Συµπεράσµατα  

 Αναφορά στα κύρια σηµεία της εργασίας, στη διαδικασία, στους αρχικούς 

στόχους και στο κατά πόσο αυτοί επιτεύχθηκαν 



 Κριτική αξιολόγηση της εργασίας συµπεριλαµβανοµένων των µεθόδων 

 Αναφορά και σχολιασµός πιθανών εφαρµογών της έρευνας και δυνατότητες 

περαιτέρω έρευνας   

 

6. Βιβλιογραφία – Αναφορές    

 


